
Copyright © European Patent Office 
All Rights Reserved 

 
Last updated: November 2004 

Document version: eOLFv2_10_SP2_EN_1104.001 
 

 

epoline® Online Filing 
User guide 

Version 2.10SP2 
 





 

 i 
 

Copyright 

© European Patent Office (EPO), 2003. All rights reserved.  

Accurate reproduction of EPO-created information contained in this 
documentation is authorised, provided the source is acknowledged and 
unless otherwise stated (eg that use is restricted or subject to prior 
permission). 

Further use of third-party works requires permission from the copyright 
holder, unless this is waived under the law applicable. 

 

Trademarks and logo 

epoline® is a registered word and device mark of the European Patent 
Organisation and may not be copied. The EPO’s official logo is likewise 
protected worldwide as an emblem of an international organisation under 
the Paris Convention for the Protection of Industrial Property.  

 

Disclaimer 

Online services under epoline® and the associated data from EPO 
databases are regularly maintained and updated. Great care has likewise 
been taken in writing the instructions for using the services provided, to 
ensure that the information supplied is correct. Furthermore, the Office 
makes every effort to prevent technical malfunctions. Given the amount 
of data and information provided, however, it is not possible to rule out all 
errors and omissions. 

The EPO therefore accepts no liability for the completeness and accuracy 
of the data and information made available in connection with these 
services, and it does not guarantee that the underlying files and the 
formats used are error-free and will not cause the user's systems to 
malfunction. Nor can the EPO guarantee that the information presented 
in this documentation about the functionality and use of  these services is 
fully up to date, complete, and without any errors or mistakes. 

 

Other access conditions 

The EPO reserves the right to modify, extend or discontinue the available 
services, in full or in part, without prior notice.  
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Intended audience 

This guide is intended for users of the Online Filing software and 
services. Only authorised users may access the system. The information 
presented here may change over time as services develop.  

 

What this guide contains 

This guide details the features of File Manager and describes the 
processes for submitting patent applications or subsequently filed 
documents electronically. The forms available depend on the Online 
Filing procedures selected during installation. 

File Manager  

File Manager contains folders representing the various stages in 
processing a patent application. It also provides: 

§ Facilities for exporting and importing forms. 
§ Address Book for storing names. 
§ Tools for information maintenance and system settings. 

 

Form processes 

§ Drafting the electronic form. 
§ Signing the form. 
§ Sending the form. 

 

Additional information 

The section on Portable Document Format hints and tips provides 
practical advice on preparing documents for submission. The Appendix 
provides supplementary information, for example a glossary of terms, a 
summary of exporting and importing features, a list of shortcut keys, 
abbreviations and acronyms. Also in the Appendix is a sample 
EP(1001E) filing showing the various stages of completion. 

 

 

 
 



 

iv epoline® Online Filing User guide 
 

Overview of Online Filing 

Online Filing enables you to submit patent applications and subsequently 
filed documents electronically over a secure Internet link. A key benefit of 
this service is that you receive the application number immediately. The 
receipt contains the exact date and time the application was received. 

The following security features are built into the Online Filing software: 

 

Authentication of 
users 

Each party knows who the other is 

Confidentiality No one else can see the data that is 
submitted 

Integrity Data transmitted and received are 
identical 

Accountability Both parties can prove receipt of 
data 

 

Online Filing modes 

Online Filing provides two modes, demo and production. The mode is 
selected at login. The default is demo mode. 

Demo mode is provided to allow users to practice with the processes of 
completing, signing and sending forms, without submitting a real filing.  
Demo mode transmissions go to a different server from production 
transmissions. 

Production mode is for real filings. 

 

Figure 1: Demo mode 

 

When demo mode is selected, File Manager is watermarked with the 
word "DEMO". 
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Figure 2: File Manager opening window 

Note All user management settings, forms and Address Book entries are 
specific to the current mode, that is demo mode or production mode, to 
ensure that any work in one is kept entirely separate from the other. 

 
 

Windows basics 

This guide assumes that you are familiar with using Microsoft® Windows 
and the mouse.  

Online Filing is a Windows-based application, so you can use standard 
Windows features such as the Close button .  

A drop-down list appears when you click the drop-down arrow . A 
shortcut menu appears when you click the right mouse button. Windows 
terms are defined in the Glossary of terms. 

Windows menu options offer keyboard alternatives to using the mouse. 
Hold down the ALT key while pressing the underlined letter.  

For example, in File Manager you can select the File option with your 
mouse, or press ALT+F. 

 

Figure 3: File Manager menu 
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Typographical conventions  

The following kinds of formatting in the text identify special information. 

 

Formatting Usage 

Bold Emphasised text. 

CAPITALS Names of keys on the keyboard appear in 
CAPS, for example, SHIFT, CTRL, or 
ALT. 

KEY+KEY Keys that you press at the same time 
appear in CAPS with a plus sign. 

 
 

EPO Customer Services 

For more information see the epoline® website 
(http://www.epoline.org/) 

If you experience difficulties in using the product, contact: 

 
EPO Customer Services 
European Patent Office 
Patentlaan 2 
NL-2288 EE RIJSWIJK 
The Netherlands 

Open: Monday to Friday, 08.00 – 18.00 hrs CET 

 
Tel.: + 31 70 340 4500 
Fax: + 31 70 340 4600 

 
e-mail: epoline@epo.org 

Internet: www.epoline.org 
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Version 2.10SP2 

This version incorporates the following improvements: 

§ Opt-out option for extended European search report (See 
EP(1001E) Request on p 10) 

Form 1001 contains a new check box: 

“Pilot project for EP first filings (ie applications claiming no priority): It is 
requested that no extended European search report be drawn up”  

which allows you to opt out of receiving an extended European search 
report (for more details, see OJ EPO 2003, 206 and OJ EPO 2004, 375).   
§ Attachment of digitally certified US priority documents to Forms 

1001E (p 51), 1038E (p 76) and 1200E (p 123). 
Since 30 July 2004, USPTO priority documents have been available also 
as electronic files, with an imaged certification statement included as part 
of a digitally signed PDF file containing TIFF images of the document 
pages. Such documents may be filed online as an attachment to Form 
1001E, 1200E or 1038E.  

See also: 

Notices from the European Patent Office  

(http://www.european-patent-office.org/news/info/2004_10_20_e.htm) 

and 

USPTO Official Gazette notice 
(http://www.uspto.gov/web/offices/pac/dapp/opla/preognotice/certcopies2
.pdf) 

 
§ Automatic online debit orders 
As of 12 August 2004, when you select a deposit account as payment 
mode on Form 1001E, RO-101E or 1200E and enter an account number, 
your debit order will automatically be carried out online. If debit orders are 
filed during working hours (08.00-18.00 hrs CET), you can check pending 
orders in epoline® Online Fee Payment usually within 30 minutes, and 
the actual deduction from your account 5-6 days later. 
§ New EPC member states and extension states 

Support for new EPC contracting states (Iceland, Lithuania) and for new 
extension states (Bosnia and Herzegovina, Serbia and Montenegro). 
§ Automatic selection of receiving office URL for PCT filings (See 

PCT Maintenance on p 64) 
The URL for the PCT plug-in is automatically selected from the database 
when you select the receiving office. This will prevent you filing with the 
“wrong” office if you forget to change or reset the URL and is particularly 
helpful in networked versions where different users might want to file to 
different offices. 

The patch for version 2.10SP1 is available via the Live Update service. 
Alternatively, you can download it from our website: 
(http://www.epoline.org/epoline/products/olf.html) 

Please note that the patch to SP2 level does not update the Amyuni 
software. The full 2.10SP2 client which will be provided later to you will 
provide an update of the Amyuni software. 
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Version 2.10 

 

Link to PatXML 

PatXML is designed to help you prepare patent applications that conform 
to EPO and WIPO standards. It provides assurance that you are filing a 
valid patent in terms of the content elements and the formatting structure. 
To do this PatXML provides a customised version of Microsoft® Word® 
for Windows.  

In the EP(1001E) Contents section, you can attach technical documents 
prepared with PatXML. For more information see PatXML attachments 
(p 42). 

 

Subsequently Filed Documents 

EP(1038E) is the name given to the form used in the European patent 
procedure to submit documents filed subsequently to an application. The 
form has been designed to allow you to: 

§ Add applicant and representative information. 
§ Submit additional documents after the patent application has been 

sent. 

For more information see EP(1038E) Subsequently Filed Documents 
(See "EP(1038E) Overview" p 67). 

Version 2.00 

XML 

Online Filing now provides integration with patent management systems. 
You may import existing XML documents from an external file and export 
the applications you prepare in either XML or compressed ZIP format. 
For more information see Export and Import summary (p 267) .Behind 
all epoline® GUIs lies XML conforming to the following PCT standard: 

Administrative Instructions under the Patent Cooperation Treaty (PCT):  

Part 7: Instructions Relating to the Electronic Filing and Processing of 
International Applications;  

Annex F: Standard for the Electronic Filing and Processing of 
International Applications, Appendix I: XML DTDs for the E-PCT 
Standard (Annex F, for short). 

For more information see WIPO electronic filing technical standards 
(http://pcteasy.wipo.int/efiling_standards). 

 

Address Book 
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The Online Filing Address Book can now be exported to or imported from 
an external file. The external file is saved in CSV format. The headings of 
the external file can be mapped to Address Book headings. For more 
information see Exporting Address Book names (p 42) and Importing 
Address Book names (p 43).  

 

Live Update 

Live Update is a service that updates the Online Filing software, the 
Maintenance tables and the Fee tables. You can set a reminder prompt 
to check for updates at regular intervals. For more information see 
General settings for epoline® FM (p 70). 
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1 Overview of File Manager 

File Manager is organised into several parts to help you process your 
form: menu, toolbar and folders. When you click a folder to select it, the 
contents of that folder are displayed. File Manager opens with the 
Templates folder selected. 

Note The examples shown here are taken from EP and PCT procedures. 
Screens may differ depending on the procedures selected during 
installation. 

 

 

Figure 4 File Manager opening window 
 

1.1 Creating new forms 

1 In File Manager, select New Form from the File menu and then 
select a form from the list. 

  
 

You can also double-click the template you wish to use. 

The New application window opens. 
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2 Type a user reference when prompted, something that is meaningful 
within your organisation (maximum of 15 characters for an EP form 
and 12 for a PCT form). This reference must be unique. It is the 
reference for this filing.  

 

Figure 5: New application, User reference 

 

Note If the option Use epoline® File Manager categories has been 
enabled in the Tools, Settings section of File Manager, the New 
application window also provides an area for creating a category or 
selecting an existing one. For more information see Settings for 
epoline® FM (See "General settings for epoline® FM" p 70). 

 

Figure 6: New application with Categories option, sample data 
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1.2 File Manager folder actions 

Folder actions depend on the folder selected. If you double-click an item 
in a folder, the system automatically activates the main function for that 
folder. For example, double-clicking an item in the Drafts folder opens 
the form for editing. Double-clicking an item in the Ready to Sign folder 
activates the signing process.  

 

Folder Double-click 

Templates Creates a new form. 

Drafts Opens form for viewing and editing. 

Ready to Sign Activates signing process. 

Ready to Send Activates sending process. 

Sent Opens form in Read Only mode. 

All Documents Displays forms in other folders, so commands 
are appropriate to the status of the selected 
item. 

 

To carry out a different command, right-click an item and select from the 
shortcut menu.  

 

Folder Right-click 

Templates Use as basis for new form. 

Delete (only customised folders can be 
deleted). 

 

Drafts View/Edit. 

Move to Ready to Sign. 

Save as Template. 

Categories. 

Delete. 
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Folder Right-click 

Ready to Sign Sign. 

View/Edit. 

Move to Ready to Send. 

Return to Drafts. 

Save as Template. 

Categories. 

Delete. 

 

Ready to Send Send. 

View/Edit. 

Return to Drafts. 

Return to Ready to Sign. 

Save as Template. 

Categories. 

Delete. 

 

Sent View 

Use as basis for new application in the 
same procedure. 

Reuse as basis for new application across 
different procedures. 

Save as Template. 

Categories. 

Delete. 

 

All Documents View. 

Save as Template. 

Categories. 

Delete. 

Displays items located in other folders, so 
shortcut menu reflects status of selected 
item. 

 

Note As you work with File Manager you can press F5 to refresh the 
view. 
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1.3 Using categories 

Categories allow you to group forms in ways that are meaningful to your 
organisation, for example by type of content or department. Forms can 
then be sorted and displayed by category. For more information see 
Sorting and changing views of forms (p 9). 

The option to use categories for new applications can be switched on or 
off in the Tools, Settings section of File Manager. Categories can be 
applied to existing forms from any File Manager folder except Templates. 

1 Right-click a form. 

2 In the shortcut menu, select Categories. 

 

Figure 7: Selecting categories 
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3 Type a category name in the Create new category box. 

4 Click Add. 

5 Add more categories as appropriate. 

6 As you add categories they are listed in the Existing categories box. 

7 To apply an existing category, select the check box. 

 

Figure 8: Assigning categories 

 



 

 Overview of File Manager 7 
 

Note You can also click Master Category List to add or delete 
categories. 

You can access the Master Category List while creating categories or 
from the File Manager Tools menu. 

 

Figure 9: Opening Master Category List 

 

The Master Category List window opens. 
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1 Type the name of a new category and click Add. 

2 To delete a category, select it in the list and click Delete. 

 

Figure 10: Master Category List, Add 
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1.4 Sorting and changing views of forms 

In addition to folders, File Manager provides a sorting facility. You can 
group forms by document or by category. For more information see 
Using categories (p 5). 

 

Figure 11: File Manager, Sorting forms 

 

1.1 Sorting by Normal view 

The Normal view lists the contents of the selected folder and displays the 
Template used, the Reference, the Applicant name and when the file 
was last saved. Additional information may be displayed depending on 
the form status, that is, which folder it is in. 

 

Figure 12: View Normal, sample data 

 

In the Normal view only, the folder contents can be sorted alphabetically 
or chronologically by clicking a column header, for example, Reference. A 
small triangle indicates the sorting applied. 
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Figure 13: Sorting by reference, normal order, sample data 

 

A second click on the same column header reverses the order.  

 

Figure 14: Sorting by reference, reverse order, sample data 

 

This order is kept when the View mode is changed. 
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Figure 15: Sorting order maintained in By Document view 

 

1.1 Sorting by document 

The By Document view lists the contents of the selected folder by 
Reference. Double-click a reference to display the list of attachments. 
Double-click an attachment to view it. 

 

Figure 16: View By Document, sample data 
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1.1 Sorting by category 

The By Category view lists the contents of the selected folder by the 
categories selected when the new form was created. Double-click a 
category to display the list of associated files.  

For more information see Using categories (p 5). 

 

Figure 17: View By Category, sample data 
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2 File Manager menu options 

The File Manager menu allows you to carry out common tasks. 

 

Figure 18: File Manager menu 

 

Menu  Description 

File New Form Creates new form of selected 
type. 

 Export  

 Address Book Saves the Address Book as a 
file in CSV format. 

 Forms Displays forms available to 
export and the folder for 
storage. 

 Import  

 Address Book Brings a CSV file into the 
Address Book. 

 Forms Brings forms back into the 
central directory. 

 XML from file Brings an XML in a compressed 
ZIP file into the central 
directory.  

 XML from folder Brings an XML file into the 
central directory. 

 Exit (Ctrl+Q) Quits the File Manager. 

Edit Delete (Ctrl+D) Removes selected item from 
folder. 

View Status Bar Indicates progress as form is 
being processed, in lower part 
of File Manager window. 

Go to Procedure Provides list of forms for 
selection. The forms available 
depend on the options selected 
when Online Filing was 
installed. 
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Menu  Description 

 Templates Provides blank forms for 
installed procedures. 

 Drafts Displays partially completed 
forms. 

 Ready to Sign Displays forms completed and 
awaiting authorisation. 

 Ready to Send Displays forms completed and 
authorised. 

 Sent Displays forms already 
transmitted. 

 All Documents Displays full list of forms in all 
stages. 

Tools Address Book 
(Ctrl+B) 

Provides details of names in 
forms. 

 Master Category 
List 

Provides facility to add and 
delete categories. 

 Maintenance Provides lists of information 
catalogues. The forms available 
depend on the options selected 
when Online Filing was 
installed. 

 Fees Provides table of fees. The 
forms available depend on the 
options selected when Online 
Filing was installed. 

 Settings Provides options for using the 
File Manager such as preferred 
PDF product. The forms 
available depend on the options 
selected when Online Filing 
was installed. 

 User Accounts Provides facilities for managing 
user accounts. This option is 
activated in Settings. 

Help epoline® File 
Manager Help  

About epoline® 
File Manager 

Accesses the online Help file. 

Displays general information 
and EPO Customer Services 
details. 
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2.1 Exporting folders 

Keeping a large number of files in central directory folders may eventually 
affect system performance. We strongly advise that you make backup 
copies and clear the folders out occasionally by archiving files to other 
storage areas on your computer system.  

2.1 Making backup copies of folders 

The original documents will still be filed in the central Online Filing 
directory. 

1 In File Manager select Export, Forms from the File menu. 

 

Figure 19: File Manager, File, Export, Forms 

The Forms Export window opens. 

The folders available for export depend on which procedures are 
installed. 

2 Type in a note if you wish. 

 

Figure 20: Forms Export, Making backup copies 

 

3 Select the folder(s) you wish to archive.  

All the documents in the folder will be moved. 
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4 When prompted select a storage area. 

5 Accept the suggested name and location, or type a name of your 
own choice and click Save. If you create your own name, make sure 
you keep the .ezf file extension. 

Note The system name consists of the date exported followed by the 
hour, minute and second. For example a file named: 

20011004_142826.ezf  

was saved on:  

4 October 2001 at 14 hours, 28 minutes, 26 seconds. 
 

2.1 Archiving folders 

With this option, the original documents are no longer filed in the Online 
Filing central directory. You can bring them back by selecting Import 
from the File menu. 

1 In File Manager select Export, Forms from the File menu. 

 

Figure 21: File Manager, File, Export, Forms 

 

The Forms Export window opens. 
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2 Type in a note if you wish. 

3 Select the option Delete items from database after archiving. 

The folders available for export depend on which procedures are 
installed. 

 

Figure 22: Forms Export, archiving folders 

 

4 Select the folder(s) you wish to archive.  

5 Click Yes at the prompt to move the complete folder contents. 

 

Figure 23: Export prompt 

 

6 When prompted select a storage area. 

7 Accept the suggested name and location, or type a name of your 
own choice and click Save. If you create your own name, make sure 
you keep the .ezf file extension. 

For information on bringing archived folders back, see Importing folders 
(p 18). 
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2.2 Importing folders 

You can bring archived folders back into the Online Filing central 
directory. For more information on archiving see Exporting folders (p 
15). 

1 In File Manager select Import, Forms from the File menu. 

 

Figure 24: File Manager, File, Import Forms 

 

2 When prompted, select the storage area and the EZF file you require, 
and then click Open.  

The Forms Import window opens. 

The folders available for import depend on which procedures are 
installed. 

 

Figure 25: File Manager, importing archived folders 

 

3 Select the folder with the forms you wish to import. 

The system checks the folders. If the files already exist in the Online 
Filing central directory, you will receive a warning message to overwrite 
or skip the import. 

4 Click Overwrite, Skip or Skip All as appropriate. 
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2.3 Exporting and importing forms 

Patent application forms can be saved outside Online Filing. These 
operations are carried out from the File menu of the patent application 
form.  

 

§ To save as XML open the form and select the option Export 
unpacked WAD to....  

Exporting unpacked WAD (p 240) 

 
§ To save as ZIP use the option Export WAD to....  
Exporting WAD (p 241) 

 

Once the forms are exported from the form menu, they can be imported 
using File Manager. 
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2.3.1 Command line functionality 
Certain File Manager functionality for XML and exporting files is available 
from the command line. Command line functionality provides the interface 
to automate the transfer of data using XML between Patent Management 
Systems (PMS) and the Online Filing system. 

“-xml” mode is designed for import from XML. The language of 
proceedings and user-reference are extracted from the XML. If the 
filename contains a space, the parameter is set in double quotes 
(“parameter”).  

“-export” mode is designed for the export of form data from the database 
into either a file or a folder. 

 

XML processing example 

fmi.exe -xml mode=production username=Administrator password= 
filename=c:\fr.zip 

fmi.exe -xml mode=production username=Administrator password=11 
foldername=c:\fr 

 

Export processing example 

fmi.exe -export mode=production username=Administrator password=11 
formtype=pctro101 userreference=pct_02 foldername=c:\pct_02 

fmi.exe -export mode=production username=Administrator password=11 
formtype=pctro101 userreference=pct_01 filename=c:\pct_01.zip 
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2.3.2 Importing XML from file (ZIP format) 
A form can be exported as WAD. This creates an XML file in 
compressed ZIP format. Exporting WAD (p 241) It can then be imported 
via File Manager as the basis for a new form. 

1 In File Manager, select Import, XML from file from the File menu. 

 

Figure 26: File, Import, XML from file 

 

2 Navigate to the file location and open the ZIP file. 

 

Figure 27: Opening ZIP file, sample data 
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3 Select an option from the Route list if appropriate. 

4 Enter a unique user reference. 

 

Figure 28: Importing file, reference information 

 

The form window opens. Edit and save as appropriate. 
 

2.3.3 Importing XML from folder 
A form can be exported as unpacked WAD. This creates a file in XML 
format. For more information see Exporting unpacked WAD. It can then 
be imported via File Manager as the basis for a new form. 

1 In File Manager, select Import, XML from folder from the File menu. 

 

Figure 29: File, Import, XML from folder 
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2 Navigate to the file location and select the folder. 

 

Figure 30: Browsing for XML folder, sample data 
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3 Select an option from the Route list if appropriate. 

4 Enter a unique user reference. 

 

Figure 31: Importing file, reference information 

 

The form window opens. Edit and save as appropriate. 
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3 File Manager toolbar options 

The File Manager toolbar options provide quick access to common tasks. 
Move the pointer over a button to see a brief description of what it does. 

 

Figure 32: File Manager toolbar 

 

Button Description 

 
Open an existing form. 

 
Open the Address Book window. 

 
Open the Maintenance window. 

 
Open the Fees window. 

 
Open the XML window. 

 
Open the Settings window. 

 
Open the Help window. 
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4 Folders for Online Filing 

The folders correspond to the procedural stages for processing forms. As 
each stage is completed the form moves to the next folder. Click a folder 
to see a list of its contents. Right-click an item in the list to open a 
shortcut menu.  

  

Folder Description 

Templates Blank or customised forms. 

Drafts Partially completed forms. 

Ready to Sign 
Forms with all information completed and 
mandatory documentation attached, waiting 
for authorisation. 

Ready to Send Forms completed and signed. 

Sent Forms which have already been 
transmitted. 

All Documents The whole list of forms in various stages. 
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4.1 Templates folder 

Templates are the “empty” forms to be completed for electronic 
correspondence such as patent applications or subsequently filed 
documents. 

You can also create your own customised forms based on standard 
forms, to include information for your organisation. For information on 
customising templates for future use, see Customising templates. The 
Templates folder displays the following information about the forms: 

§ Template 
§ Type of procedure 

 

4.1.1 Creating new forms from a template 
1 In the File Manager Templates folder, double-click the template you 

wish to use. The forms available depend on the options selected 
when Online Filing was installed. 

 

Figure 33: Templates folder 

 

Templates shortcut menu 

Right-click an item in the Templates folder to see the shortcut menu. You 
can use the template as the basis for a new application or delete it. To 
delete a customised template right-click it and then select Delete from the 
shortcut menu.  

Note You can only delete your own customised templates. You cannot 
delete the standard templates. 
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4.1.2 Customising templates 
You can customise templates to save reusable data such as names, 
language preferences, designated states and payment details. 

To customise a template: 

1 Create a new form. 

2 Complete as many of the details on the form as you wish to save. 

3 In the form, select Save as Template from the File menu. 

4 When prompted, type a reference name for the template. 

 

Figure 34: Saving template 

 
To use the new template: 

1 Click the Templates folder to display the list. 

2 Double-click the template you require. 

This opens a new copy. 

 

Figure 35: Templates, Customised 
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Note You can also save existing data for reuse as XML or ZIP files: 

§ Exporting unpacked WAD (p 240), saving as an XML file. 
§ Exporting WAD (p 241), saving as an XML file in compressed ZIP 

format. 
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4.2 Drafts folder 

The Drafts folder contains forms in preparation. It is good practice when 
working with computer applications to save your work regularly.  The 
Drafts folder displays the following information about the forms: 

§ Template 
§ Reference 
§ Applicant 
§ Last Saved 

 

 

Figure 36: Drafts folder 

 

To save your work: 

1 With the form open, select Save as Draft from the File menu. 
This saves the form to the Drafts folder. 
The form remains open for you to continue working. 

To close the form and save as a draft: 

1 With the form open, click the Windows Close button. 
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Figure 37: Windows Close button, sample data 

 

2 At the confirmation prompt select Save as Draft. 

 

Figure 38: Confirmation, Save options 

 

Drafts shortcut menu 

Right-click a draft form to see a list of options. For example you can Save 
as Template from here, or move it to the Ready to Sign folder, if it 
meets the minimum requirements to do this, that is, if the mandatory 
information has been completed and the mandatory documents attached. 
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4.3 Ready to Sign folder 

The Ready to Sign folder contains forms with the mandatory information 
completed, awaiting signature. If you make any changes to the 
information after signing, the signature is removed and the form is 
returned to the Ready to Sign folder. The Ready to Sign folder displays 
the following information about the forms: 

§ Template 
§ Reference 
§ Applicant 
§ Last Saved 

 

 

Figure 39: Ready to Sign folder 

 

You may initiate the signing process from the form itself or from the File 
Manager Ready to Sign folder. Select a form in the Ready to Sign folder 
and double-click it. 

You can select a form in the Ready to Sign folder and save it as a 
customised template.  

 

Ready to Sign shortcut menu 

Right-click an item in the Ready to Sign folder to see the shortcut menu. 
You can view the selected item and edit it, sign it, move it to another 
folder, save as template or delete it. 
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4.4 Ready to Send folder 

The sending process is initiated from File Manager. The Ready to Send 
folder contains forms that have been signed and are awaiting electronic 
transmission. If you make any changes to the information after signing, 
the signature is removed and the form is returned to the Ready to Sign 
folder. 

The Ready to Send folder displays the following information about the 
forms: 

§ Template 
§ Reference 
§ Applicant 
§ Last Saved 
§ Retry 

To send a form you require a smart card and PIN.  

To send a form from File Manager: 

1 In the Ready to Send folder double-click a form. 

Alternatively, right-click it and then select Send from the shortcut menu. 

 
 

For more information on completing the procedure see Sending 
applications (See "Sending forms" p 259). 

 

Ready to Send shortcut menu 

Right-click an item in the Ready to Send folder to see the shortcut menu. 
You can view the selected item and edit it, return it to the Drafts or 
Ready to Sign folder, save it as a template or delete it. 
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4.5 Sent folder 

The Sent folder displays the files that have already been transmitted 
electronically. The following information is displayed: 

§ Template 
§ Reference 
§ Application number from receipt 
§ Applicant 
§ Last saved 

 

 

Figure 40: Sent folder, sample data 

 

Sent shortcut menu 

Right-click an item in the Sent folder to see the shortcut menu. You can 
view the selected item, use it as the basis for new application for the 
same procedure, reuse data for a different procedure, save it as a 
template or delete it.  
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4.6 All Documents folder 

The All Documents folder displays the whole list of forms from other 
folders, indicating where each one is stored. Sent forms automatically 
display the application number assigned. 

The All Documents folder displays the following information about the 
forms: 

§ Template 
§ Reference 
§ Application Number 
§ Applicant 
§ Last Saved 
§ Status 
 

 

Figure 41: All Documents folder, sample data 

 

All Documents shortcut menu 

Right-click an item in the All Documents folder to see the shortcut menu. 
You can view the selected item, save as template or delete it. Since the 
All Documents folder displays items located in other folders, the shortcut 
menu varies depending on the status of the selected item. 

 
 



 

36 epoline® Online Filing User guide 
 

5 Address Book 

The Address Book is a facility for storing contact details. You can 
access the Address Book from File Manager and from the procedural 
form itself. 

 

Option Location 

Create names in the 
Address Book first and then 
use them in a patent 
application. 

File Manager, Tools, Address Book. 

Export names to an 
external file (CSV). 

File Manager, Export, Address 
Book. 

Import names from an 
external file (CSV). 

File Manager, Import, Address Book. 

Save names in the 
Address Book which have 
been entered in the current 
patent application. 

Names section of the form. 

Add names from the 
Address Book to the current 
application, or reuse some 
of the details, for example 
an address or telephone 
number. This option helps 
to save retyping. 

Names section of the form, in the 
Details window for role selected, for 
example in the Applicant window. 

 

Note The examples in this section are taken from EP(1001E) but apply to 
other forms as well. 
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5.1 Creating names in the Address Book 

1 In File Manager select Address Book from Tools the menu.  

The Address Book window opens. 

2 Click Add. 
 

 

Figure 42: Address Book, Add 

 

5.1.1 Address tab 
The Address Book opens with the Address tab selected. 

1 Select the option either for Legal person (corporate entities) or 
Natural person. 

2 Enter the name. 

The options for First name and Title are only available for Natural 
persons. 
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3 Complete the address details. 

 

Figure 43: Address Book, Address tab 

 

5.1.1 States tab 
The States tab contains information about Nationality and Country of 
residence for natural persons. 

 

 

Figure 44 States tab 
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5.1.1 Telephone and e-mail tab 
The Tel./e-mail tab contains telephone, fax and e-mail information. 

 

Figure 45: Address Book, Tel/e-mail tab 

 

5.1.1 Registration tab 
The Registration tab contains information about Route, Role and 
Registration Number. 

1 Double-click in the blue area under a heading to see a drop-down list 
of options. 

2 Select the options you require. 

 

Figure 46: Address Book, Registration tab 
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Note Once you have created entries in the Address Book, you can use 
them in the Names and Signatories sections of a form. 

Address Book entries are specific to the current mode, that is to demo 
mode or to production mode, to ensure that any work in one is kept 
entirely separate from the other. 

 

5.1 Editing names in the Address Book 

1 In File Manager select Address Book from the Tools menu.  

The Address Book window opens. 

2 Select the name you wish to change. 

3 Click Open. 

The Address Book window opens. 

4 Enter the information you require. 

 

5.1.1 Deleting names from the Address Book 
Once a name is created in the Address Book window, the Delete button 
becomes available. 

1 To delete the name, select it and click Delete. 

 

5.1 Importing and exporting Address Book 
names 

The Address Book can be exported to or imported from an external file. 
The external file is saved in CSV format. The field names of the external 
file can be mapped to Address Book field names. For more information 
see Importing Address Book names (p 43) and Exporting Address 
Book names (p 42).  
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5.1.1 Using Address Book categories 
You can create categories for your Address Book entries. You can also 
assign existing categories. For more information see Using categories 
(p 5). 

1 In File Manager, Tools, Address Book, click Categories. 

 

Figure 47: Address Book categories 

 

The Address Book Maintenance window opens. 



 

42 epoline® Online Filing User guide 
 

1 In the Create new category box, type a name and click Add. 

Or select a check box for existing categories. 

 

Figure 48: Address Book Maintenance 

 

Once you have assigned categories, you can use them to sort the 
contents of the Address Book. 

 

Figure 49: Sorting Address Book by category 

 
 

5.1.2 Exporting Address Book names 
1 In File Manager, select Address Book from the File, Export menu. 

The Save As window opens. 
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2 Select a location and enter a file name. 

3 Click Save. 

The file is saved in CSV (Comma Separated Values) format.  

 

Figure 50: Saving as a CSV file 

 

Note The application associated with CSV file formats depends on your 
system setup. 

 
 

5.1.3 Importing Address Book names 
1 In File Manager, select Address Book from the File, Import menu. 

2 Navigate to the file location and select the document you wish to 
import. 

The Import Address Book window opens. 

The Address Book fields are listed on the left, with matching CSV file 
fields on the right. 
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3 If a CSV name differs from an Address Book name, type the CSV 
name that corresponds, so that it can be identified correctly during 
the import process. 

 

Figure 51: Importing Address Book 

 

If the import process finds a duplicate name, it displays the following 
message. 

 

Figure 52: Message for importing duplicates 

 

1 Select the option you require. 

Select Overwrite to replace the existing name with the imported data. 

Select Skip if you do not wish to import the duplicate name. If you select 
Skip all, no duplicate names are imported. 

Select Add as new Record to import the existing name with the 
corresponding entity type, states, address and correspondence 
information.  



 

 Address Book 45 
 

Note If you want to import an Address Book after you have processed it 
with an external program, please ensure that the entries of the CSV file 
are comma delimited. Some external programs may save CSV files as 
semicolon delimited rather than as comma delimited. 

The Route, Role and Registration numbers must be within one comma 
delimited field, but divided by a vertical bar |. In case of more than one 
registration, there must be a multiple of these three data items, and all of 
them must be consecutively divided by a vertical bar within the one field 
for Role. 

If no person type of either natural or legal is given for a record, a legal 
person type is assumed by default and will result in all name components 
appearing under Name instead of the various fields for first name and 
name (ie surname). 
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5.2 EP(1001E) Saving names to the Address 
Book 

Once you enter details in the Names section of a form, you can save 
them in the Address Book for future use.  

1 In the Names section, select the name you wish to save, and then 
click Address Book. 

 

Figure 53: EP(1001E) Saving names to the Address Book 

 

The Address Book exchange window opens. The names from the form 
are listed in the lower half of the screen. 



 

 Address Book 47 
 

2 Click the one you wish to save, and then click Copy to Address 
Book. 

The name is added to the existing Address Book names in the upper half 
of the window. 

 

Figure 54: Address Book exchange, Copy to Address Book, sample data 

 

Note There is a currently a limitation on the number of records in the 
address book imposed by a BDE (Borland Data Exchange) setting. 

The workaround to overcome the limit to the number of address book 
entries is the following:  

1 Go to Windows Start->Settings->Control Panel->BDE Administrator. 

2 Find database eOLFi (production) or eOLFdi (demo) - highlight it in 
the list.  

3 In the list of parameters on the right change value of "BLOBS TO 
CACHE" from default 64 to the number of your maximum expected 
address book entries multiplied by 2.  

4 Click the Apply button in the BDE Administrator toolbar.  
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5.3 Adding names from the Address Book 

You can enter names in your Address Book and then use them in forms. 
To add a name to a form from the Address Book: 

1 In the Names section select a function from the list.  

2 Click Address Book. 

 

Figure 55: EP(1001E) Adding Applicant from Address Book 

 

The Address Book Exchange window opens. 

The existing Address Book names are displayed in the upper half of the 
screen.  
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3 Click a name to select it, and then click a function button in the 
middle of the screen, for example Applicant. 

The entry is added to the Names section of the current form. 

 

Figure 56: Address Book exchange 

 

Note To remove a name you have added from the Address Book, select 
it and then click Remove. 
 

 
 

5.4 Reusing Address Book details 

To save retyping you can use the Address Book to complete names. If 
the new person has some of the same details as an existing contact, say 
for example the same address or telephone number, type in the new 
information as appropriate. 

1 In the EP(1001E) Names section, double-click a role. 

The window opens for the role you have selected. 
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2 Click the Address Book button. 

 

Figure 57: Applicant details with sample data, Address Book button 

 

3 If multiple entries exist, navigation arrows appear. Use these to scroll 
through the Address Book entries. 
 

 

4 Select the name you wish to use. 

Type the new information.  

 
 

5.5 Address Book smart match 

Online Filing provides a smart search facility to save time finding the right 
Address Book entry. 

5 Select the type of person, ie natural or legal. 

6 Complete at least one letter or number in one or more of the fields. 

Note The registration or country coding fields cannot be used for smart 
search. 

The entries are case-sensitive. 
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7 Click the Address Book button. 

If there is more than one Address Book entry matching your criteria, the 
red navigation arrows at the top will be activated to allow you to navigate 
through the list. 

Example 1 

In this example, "A" is entered in the Name field. 

 

Figure 58: Smart search, "A" entered in Name field 

 

The search finds natural persons whose names begin with "A". Clicking 
the left navigation arrow displays the previous name, clicking the right 
arrow displays the next name. 

 

Figure 59: Smart search finds names starting with "A" 
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Example 2 

In this example, "A" is entered in the Name field and "E" is entered in the 
City field. 

 

Figure 60: Smart search, "A" entered in Name and "E" in City 

 

The search finds natural persons whose names begin with "A" in cities 
beginning with "E". In our example, there is only one matching entry, so 
the navigation arrows are not activated. 

 

Figure 61: Smart search finds names starting with "A" and cities with "E" 
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6 Master Category List 

6.1 Using categories 

Categories allow you to group forms in ways that are meaningful to your 
organisation, for example by type of content or department. Forms can 
then be sorted and displayed by category. For more information see 
Sorting and changing views of forms (p 9). 

The option to use categories for new applications can be switched on or 
off in the Tools, Settings section of File Manager. Categories can be 
applied to existing forms from any File Manager folder except Templates. 

1 Right-click a form. 

2 In the shortcut menu, select Categories. 

 

Figure 62: Selecting categories 
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3 Type a category name in the Create new category box. 

4 Click Add. 

5 Add more categories as appropriate. 

6 As you add categories they are listed in the Existing categories box. 

7 To apply an existing category, select the check box. 

 

Figure 63: Assigning categories 
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Note You can also click Master Category List to add or delete 
categories. 

You can access the Master Category List while creating categories or 
from the File Manager Tools menu. 

 

Figure 64: Opening Master Category List 

 

The Master Category List window opens. 
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1 Type the name of a new category and click Add. 

2 To delete a category, select it in the list and click Delete. 

 

Figure 65: Master Category List, Add 
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6.2 Sorting and changing views of forms 

In addition to folders, File Manager provides a sorting facility. You can 
group forms by document or by category. For more information see 
Using categories (p 5). 

 

Figure 66: File Manager, Sorting forms 

 

6.1 Sorting by Normal view 

The Normal view lists the contents of the selected folder and displays the 
Template used, the Reference, the Applicant name and when the file 
was last saved. Additional information may be displayed depending on 
the form status, that is, which folder it is in. 

 

Figure 67: View Normal, sample data 

 

In the Normal view only, the folder contents can be sorted alphabetically 
or chronologically by clicking a column header, for example, Reference. A 
small triangle indicates the sorting applied. 
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Figure 68: Sorting by reference, normal order, sample data 

 

A second click on the same column header reverses the order.  

 

Figure 69: Sorting by reference, reverse order, sample data 

 

This order is kept when the View mode is changed. 
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Figure 70: Sorting order maintained in By Document view 

 

6.1 Sorting by document 

The By Document view lists the contents of the selected folder by 
Reference. Double-click a reference to display the list of attachments. 
Double-click an attachment to view it. 

 

Figure 71: View By Document, sample data 

 

6.1 Sorting by category 

The By Category view lists the contents of the selected folder by the 
categories selected when the new form was created. Double-click a 
category to display the list of associated files.  
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For more information see Using categories (p 5). 

 

Figure 72: View By Category, sample data 
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7 Maintenance 

Online Filing includes general catalogues of information as a service to 
the intellectual property community. The Maintenance catalogues 
available depend on the procedures selected when the software was 
installed. 

The data are divided into two types: 

§ Common maintenance information such as names of countries and 
currencies used, related to worldwide patent processes. 

§ Maintenance catalogues specific to the patent process. 
 

Live Update provides a service for updating the Online Filing software 
itself, plus the maintenance and fees data. The Live Update option is 
located in File Manager Tools, Settings. 

 

 

 
 

7.1 Common maintenance 

1 In File Manager, select Maintenance, Common Maintenance from 
the Tools menu. 

The Maintenance Table Editor window opens, displaying a list of 
catalogues on the left. The date on the right indicates when the 
information was last updated.  

2 Click a catalogue to display the list of information. 
The Browse tab is selected. 

3 Scroll through the list to find the entry you require. 

4 Double-click the entry to see the detailed information. 

You can also click the Detail tab. 
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In the example below, the Depositary Institutions catalogue is selected. 
The option NCTC is double-clicked to see the details. 

 

Figure 73: Maintenance Table Editor, Common maintenance catalogues 

 
The information about the NCTC was accurate as of 27 July 2003. 

 

 

Figure 74: Maintenance Table Editor, Common maintenance details 
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7.2 EP Maintenance 

1 In File Manager, select Maintenance, EP Maintenance from the 
Tools menu. 

The Maintenance Table Editor window opens with EP options 
displayed.  

The EP tables are listed on the left. The Browse tab is selected. 

The date on the right indicates when the information was last updated. 
The required date can be set using the Calendar button at the top right.  

2 Scroll through the list on the left side of the screen to see the tables 
offered.  

3 Click a table to select it. 

4 Double-click an entry in the table to see the detailed information. 

You can also click the Detail tab. 

 

Figure 75: Maintenance Table Editor, EP maintenance 

 

Note You must have Administrator rights on the system in order to modify 
the data in the catalogue. 
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7.3 PCT Maintenance 

1 In File Manager, select Maintenance, PCT Maintenance from the 
Tools menu. 

The Maintenance Table Editor (PCT receiving Offices) window opens.  

The PCT receiving Offices are listed on the left. The Browse tab is 
selected. 

The date on the right indicates when the information was last updated. 
The date can be set using the Calendar button at the top right.  

2 Scroll through the list on the left side of the screen to see the tables 
offered.  

3 Click a table to select it. 

4 Double-click an entry in the table to see the detailed information. 

You can also click the Detail tab. 

 

Figure 76: PCT Maintenance Table Editor 

 

Note You must have Administrator rights on the system in order to modify 
the data in the catalogue. 
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8 Fees 

Online Filing provides fee schedule tables. The fee schedules available 
depend on the procedures selected when Online Filing was installed. The 
fee amounts can be updated, and it is the user's responsibility to update 
regularly when changes occur. 

Live Update provides a service for updating the Online Filing software 
itself, plus the maintenance and fees data. The Live Update option is 
located in File Manager Tools, Settings. 

The Tools, Fees section of File Manager allows you to display fee 
schedules in date order (normal) or grouped by type of currency (by 
currency) 

1 In File Manager select Fees from the Tools menu.  

The Fees window opens. 

2 To see the detailed filing fees double-click a currency abbreviation 
in the Fees list. 

The Fee schedule window opens. 

3 Scroll through the list to see the information. 
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8.1 EP Fees 

1 In File Manager select Fees, EP Fees from the Tools menu.  

The EP Fees window opens. 

2 Double-click an item to view the details. 

 

Figure 77: EP Fees 

 

The Fee Schedule window opens, with the kind of fee and amounts 
displayed. 

 

Figure 78: Fee schedule 
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8.2 PCT Fees 

1 In File Manager select Fees, PCT Fees from the Tools menu.  

The PCT Fees window opens. 

You may display fee schedules in date order (normal) or grouped by type 
of currency (by currency) 

2 To sort by currency, click the heading RO ISA Currency.  

To sort in reverse order (A-Z or Z-A), click again. 

3 To sort by date, click the heading Date. 

 

Figure 79: PCT Fees, Sort by RO ISA currency 

 

1 Double-click an item to view the details. 

The PCT Fee Schedule Detail window opens, with Definitions 
displayed. 
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2 Click Fees Detail. 

 

Figure 80: PCT fee schedule detail 

 

Note Request fee templates can be selected from the drop down menu 
at the top right. 

 

Figure 81: PCT fees, Requesting fee templates 
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8.3 Updating fees 

To update a fee: 

1 With the fees sorted by Normal order in the Fees window, double-
click a currency to open the Fee Schedule window. 

The new amount is displayed against a blue background. 

Double-click an amount in the New amount column. 

 

Figure 82: Selecting filing fee 

 

The background changes to white. 

2 Enter the new amount. 

 

Figure 83: Entering a new filing fee 

 

Live Update 

Live Update provides a service for updating the Online Filing software 
itself, plus the maintenance and fees data. The Live Update option is 
located in File Manager Tools, Settings. 
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9 Settings 

The Tools, Settings section of File Manager provides options that affect 
general system functionality, as well as specific options for filing forms. 
Once User Management is enabled, system critical settings can only be 
accessed by a user assigned the Administrator role. For more information 
see System critical settings (p 15). The application must be restarted 
for new settings to take effect. 

1 In File Manager select Settings from the Tools menu. 

The General options are displayed. 

2 Set the options you require. 

3 Restart the application for the new settings to take effect. 

  
 

9.1 General settings for epoline® FM 

The Tools, Settings section of File Manager provides options that affect 
general system functionality, as well as specific options for filing forms. 
Once User Management is enabled, you can only access system-critical 
settings if you have been assigned the Administrator role. System 
critical settings (p 15). The application must be restarted for new 
settings to take effect. 

9.1.1 General option 
1 In File Manager, select Settings from the Tools menu. 

The version and installation date for epoline® File Manager are 
displayed. 
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Note The network settings depend on how your company is set up to 
send and receive data. Typically, an IP address for your company will 
need to be entered in the Proxy Server box, as well as the Port 
information. If you are uncertain whether the Proxy Server, Port, User 
and Password details are needed in your situation, consult you IT 
department.  

Suggestion Try using the same settings as your Internet access 
program, eg Internet Explorer. 

For more information on the terms used see the Appendix. 

When contacting EPO Customer Services it is always helpful to mention 
the Build number of the respective form module. This version/build 
number will also be checked when using Live Update. 

 

Figure 84: General options for epoline® FM 

 

In the General options you can enable User Management. This option is 
only available to the Administrator role. For more information see User 
Management in Online Filing (p 7). 

With either the General or the Setting option displayed, you can enable 
the option Use epoline® File Manager categories. Once this check box 
is selected, the option to use categories is available when creating a new 
application. 
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9.1.1 Setting option 
The Setting option allows you to set address preferences, startup 
language and the font used to display Online Filing. 

1 In File Manager, select Settings from the Tools menu. 

The Options window opens. 

2 Click Setting on the left. 

3 Select the options you require. 

 

Figure 85: Setting option for epoline® FM 
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9.2 Live Update 

Live Update provides a service for updating the Online Filing software 
itself, plus the maintenance and fees data. 

1 In File Manager select Settings from the Tools menu. 

2 Click Live Update. 

3 Select the check box Enable software Update system. 

The Check for update option is set to 1 day. You may change this if you 
wish. 

The first time you open File Manager on the designated day, the update 
is initiated automatically. 

4 To activate Live Update immediately, click Check Now. 

 

Figure 86: Live Update option 

 

For reference, please note the Live Update server URL: 

http://www.epoline.org/olfliveupdate/liveupdate_def.xml  
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If new updates are found, a prompt appears. 

1 Click Yes to view a list of updates appropriate to the current 
installation. 

Note The software itself is NOT downloaded or installed at this stage. 

 

Figure 87: Live Update prompt, new updates found 

 

Note If you select the option Enable software update system, the 
system checks for updates BEFORE it opens File Manager. This is the 
recommended option. If you disable this option and click Check Now, 
you must first close File Manager manually before carrying out any 
installation updates.  

Live Update installations. 
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9.3 Settings for EP Filing 

The settings window for EP filing displays information about the 
software version, installation date and the server addresses or URLs 
for demo and production modes. The URLs are defined here for each 
mode and for each form. The default URL settings depend on the 
country option chosen during installation. Any change to these settings 
should be the responsibility of a technical system administrator.  

If the settings have been modified in error, the correct settings can be 
obtained from EPO Customer Services (p vi).  

The default method of submission for forms is epoline®. The default can 
be changed to CD-R. For more information see CD-R submission (p 6). 
It is also possible to select the method of submission for a particular form 
during the sending process.  

 

1 In File Manager select Settings from the Tools menu. 

2 Click EP filing on the left. 

3 Select the appropriate option on the left, either EP Form 1001E or 
Euro-PCT(1200E). 

4 Make the appropriate changes. 

5 Restart the application for the new settings to take effect. 

 

Figure 88: Settings for EP filing, EP Form 1001E 
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9.4 Settings for PCT Filing 

The settings window for PCT filing displays information about the 
software version, installation date and the server addresses or URLs 
The URLs are defined here for each mode, both demo and production. 

The default URL settings depend on the country option chosen during 
installation. Any change to these settings should be the responsibility of a  
technical system administrator. For assistance please contact EPO 
Customer Services (p vi). You can select the method of submission for 
forms, either epoline® or CD-R. For more information see CD-R 
submission (p 6). 

If the settings have been modified in error, the correct settings can be 
obtained from EPO Customer Services. For assistance please contact 
EPO Customer Services (p vi).  

The default method of submission for forms is epoline®. The default can 
be changed to CD-R. For more information see CD-R submission (p 6). 
It is also possible to select the method of submission for a particular form 
during the sending process.  

Note The URL for the PCT plug-in is automatically selected from the 
database when you select the receiving office. This will prevent you from 
filing with the “wrong” office if you forget to change or reset the URL and 
is particularly helpful in networked versions where different users might 
want to file to different offices. 

 

1 In File Manager select Settings from the Tools menu. 

2 Click PCT filing on the left. 

3 Make the appropriate changes. 

4 Restart the application for the new settings to take effect. 
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Figure 89: Settings for PCT filing 
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10 CD-R submission 

File Manager provides an alternative to sending forms over a secure 
Internet link. You can write the file to a Compact Disk - Recordable 
(CD-R) and then send it by mail/express delivery. This only applies to 
procedures permitting CD-R submission. This might be appropriate for 
very large files that would take considerable time to transfer over a 
network link. 

You can select the method for each submission individually, during the 
sending process. For more information see Loading a form onto a CD 
(p 266). Or you can set CD-R as the default option in File Manager, 
Tools, Settings. A default directory can be set where the submission will 
be stored (this can also be on an intermediate place of storage, for 
example a local hard drive, before writing it to a CD-R. 

For this procedure you need a CD writer.  

1 In  File Manager select Settings from the Tools menu. 

2 Select the appropriate filing option on the left. 

3 Select the option CD-R. 

Note From now on, all forms will be sent this way until you change it back 
to the Internet link option. 

4 Click the Browse button to select a CD-R directory.  

This is where the forms are stored. 

 

Figure 90: CD-R submission 
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11 User management in Online Filing 

User Management has been implemented in order to make it possible to 
share data over a network. It also provides a unified approach to secure 
software access and maintenance information for the single user version 
(which uses an internal database) and for the real database version 
working via full database servers. The main reason for user management 
is that the software needs to distinguish between different users in order 
to provide mechanisms for data sharing. 

User management can be switched on and off via File Manager. After 
activating or deactivating the User management option, the application 
must be restarted.  

User management settings are specific to the current mode, that is, to 
demo mode or to production mode, to ensure that any work in one is kept 
entirely separate from the other. 

Once user management is activated, the user is prompted to log in with a 
name and password. These are case sensitive, so they must be typed 
exactly as created in upper and lower case. After logging in, the user 
obtains access rights corresponding to the group he belongs to.  

Note If a user tries to carry out a procedure that is not within his rights, he 
will receive a warning message that he does not have appropriate rights. 

If a user’s access rights are not sufficient to perform certain operations, 
the Administrator should move him or her to a more appropriate group. 

11.1 User group roles 

There are four possible groups for users: 

 

Group Role 

Administrators Once user management is enabled, Administrators 
can create accounts and assign passwords for other 
roles. They cannot carry out the functions related to 
preparing, signing and sending patent applications. 
Only Administrator can change system critical 
settings. 

Assistants Assistants can prepare patent applications. They 
cannot sign or send applications. 

Secretaries Secretaries cannot prepare or sign patent 
applications. This role’s sole function is to send 
applications. 
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Legal 
Representatives 

Legal Representatives cannot create or manage 
accounts. They can carry out all functions related to 
patent applications, that is, prepare, sign and send 
them. 

 

11.1 Summary of group rights 

 

 User 
accounts Prepare Sign Send 

Administrator X    

Assistant  X   

Legal 
Representative 

 X X X 

Secretary    X 

 

 
 

11.2 Enabling user management 

If it is necessary to restrict access to forms, software and/or maintenance 
information, then user management has to be activated. 

1 Start File Manager. 

2 Log in as the Administrator. 

3 From the menu, select Tools, Settings. 

The File Manager Options – General window opens. 
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4 Select the User Management enabled option. 

 

Figure 91: User Management enabled 

 

5 Close the Options dialogue box and File Manager. 

6 Restart Online Filing.  

7 When the login prompt appears, log in as the Administrator.  

 

Figure 92: Logging in as Administrator 
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11.3 Creating user accounts 

Once you have enabled User Management and logged into File 
Manager as Administrator you can create new user accounts, set 
passwords for them, delete or disable existing user accounts as well as 
move existing users from one group to another. 

If a person has more than one role, he or she must be assigned a 
different user name and password for each role. In order to carry out the 
functions of another role, the user must log out of File Manager and log in 
again with the other name and password. 

To access these functions: 

1 As Administrator log into File Manager. 

2 Select User Accounts from the Tools menu. 

This option only appears once User Management is enabled. For more 
information see User Management in Online Filing (p 7). 

 

Figure 93: File Manager, Tools, User Accounts 

 

The User Accounts window opens. It consists of two tabs, Browse and 
Properties. The Browse tab displays a list of all users registered in the 
system, including their description and type (the group they belong to). 
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To create a new user account: 

1 Click the Properties tab in the User Accounts window.  

2 Click Add. 

3 Enter the details for the person, that is, user name, description and 
password. Enter the password again in the Confirm password box. 

4 Select a role from the Group list. 
 

 

Figure 94: Adding user accounts 
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11.4 Changing user properties 

The following actions are possible within the Properties tab of the User 
Accounts window. 

 

Action Comment 

Add  Add a new user. 

Edit  Edit properties of an existing user. 

Remove  Remove the specified user from the list of users. 

OK Confirm changes for the current user. 

Cancel Cancel changes for the current user. 

Account disabled Disable any account of a user. 

 

To change the properties for a user: 

1 As Administrator log into File Manager. 

2 From the menu select Tools, User Accounts. 

The User Accounts window opens. 

3 In the User Accounts window, Browse tab, select the user. 

4 Click the Properties tab. 

5 Click Edit and make the changes you require. 

 

 
 

11.5 Disabling user accounts 

To disable all accounts for a particular user: 

1 As Administrator log into File Manager. 

2 Select User Accounts from the Tools menu. 

The User Accounts window opens. 
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3 In the Browse tab select the user you wish to disable and then click 
the Properties tab. 

4 Click Edit, and then select the Account disabled option. 

 

Figure 95: User accounts, Account disabled 

 

Note To delete an individual user account, select the name and then click 
Remove. 
 
 

11.6 Assigning an Administrator password 

It is recommended that a password be assigned to the Administrator, as 
initially it is not password protected.  Assigning a password helps to keep 
your software and data secure. User Management must be enabled 
before a password can be assigned. For more information see User 
Management in Online Filing (p 7). 

To assign a password to the Administrator account: 

1 As Administrator log in to the File Manager. 

2 From the menu select Tools, User Accounts. 

The User Accounts window opens. 

3 With the Browse tab selected, click the Administrator name and 
then click the Properties tab. 

The Properties for the Administrator are displayed. 
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4 Click Edit. 

5 Type in the password for the Administrator. 

6 Type the password again in the Confirm password box. 

 

Note Administrator is a predefined user name. This user name cannot 
be removed from the system, but it can be changed. The Administrator 
can create users and add them to the Administrator group. Any user with 
Administrator privileges can log into the system and perform all 
Administrator tasks, including the removal of other users. It should be 
noted, however, that users are not allowed to remove themselves from 
the system, nor can the Administrator user be removed.  
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11.7 System critical settings 

Once User Management is enabled, system critical settings can only be 
accessed by a user assigned the Administrator role. These options are 
located in the Tools, Settings section of File Manager. The application 
must be restarted for new settings to take effect. 

11.7.1 epoline® FM settings 
A user logged in as Administrator will have access to these options for 
epoline® FM. 

§ Security and user management.  
§ Network settings. 
§ Option to use epoline® File Manager categories. For more 

information see Using categories (p 5). 

 

Figure 96: Setting options for epoline FM, Administrator role 

 

If the user is not logged in as Administrator, the same options will be 
unavailable. 
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Figure 97: Setting options unavailable for epoline FM 

 

11.7.1 Network settings for form filing 
An Administrator may set the server URLs for demo and production 
modes, for the filings listed on the left. For more information see Settings 
(p 70). 

 

Figure 98: Network settings for Administrator role, EP filing 

 

If the user is not logged in as Administrator the same options will be 
unavailable. 
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Figure 99: Setting options unavailable for EP filing 
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12 EP(1001E) Overview 

EP(1001E) is the electronic equivalent of Form 1001 for submitting a 
European patent application.  

EP(1001E) is organised into several parts to help you process your 
application: menu, toolbar and sections. When you click a section to 
select it, the options for that section are displayed. These represent the 
types of information you need to complete for the patent application.  

Note The Appendix contains a worked example of an EP(1001E) filing. 
For more information see Sample EP(1001E) filing (p 269). 

 

12.1 Completing information in EP(1001E) 

As you prepare the application, two features will help you decide whether 
the information is complete and correct: 

For more information see Traffic lights (p 235) and Validation 
messages (p 235). 

 
 

12.2 Creating new EP(1001E) forms 

1 In File Manager select New Form, EP(1001E) from the File menu. 

 

Figure 100: Creating a new Form EP(1001E) 

 

You can also create a new form in File Manager by double-clicking the 
template named EP(1001E).  
The New application window opens. 

2 Select an option from the Language of the proceedings list. 

3 Enter a user reference.  

This reference must be unique. It is the name of this patent application. 
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4 Select the option to use File Manager categories if you wish.  

Categories allow you to group forms in a way that is meaningful to your 
organisation, for example, by type of content or department. Forms can 
then be sorted and displayed by category. For more information see 
Using categories (p 5). 

 

 
 

12.3 Using categories 

Categories allow you to group forms in ways that are meaningful to your 
organisation, for example by type of content or department. Forms can 
then be sorted and displayed by category. For more information see 
Sorting and changing views of forms (p 9). 

The option to use categories for new applications can be switched on or 
off in the Tools, Settings section of File Manager. Categories can be 
applied to existing forms from any File Manager folder except Templates. 

1 Right-click a form. 

2 In the shortcut menu, select Categories. 

 

Figure 101: Selecting categories 
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3 Type a category name in the Create new category box. 

4 Click Add. 

5 Add more categories as appropriate. 

6 As you add categories they are listed in the Existing categories box. 

7 To apply an existing category, select the check box. 

 

Figure 102: Assigning categories 
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Note You can also click Master Category List to add or delete 
categories. 

You can access the Master Category List while creating categories or 
from the File Manager Tools menu. 

 

Figure 103: Opening Master Category List 

 

The Master Category List window opens. 
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1 Type the name of a new category and click Add. 

2 To delete a category, select it in the list and click Delete. 

 

Figure 104: Master Category List, Add 
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12.4 EP(1001E) Sections 

EP(1001E) sections organise the information you need to complete a 
European patent application.  

 

Section Description 

Request 
The Request section of EP(1001E) is 
where you request the grant of a 
European patent and give the 
application a title and set the language. 

Names 
The Names section of EP(1001E) is 
where you enter the details of the 
applicant, representative and inventor. 

States 
The States section of EP(1001E) is 
where you designate the countries in 
which you require patent protection. 

Priority The Priority section of EP(1001E) is 
where you claim priority. 

Biological Material 

The Biological Material section of 
EP(1001E) is where you input details of 
biological material filed if relevant and 
give the name of the depositary 
institution. 

Contents 
The Contents section of EP(1001E) is 
where you attach the description, claims 
and other documents. 

Payment The Payment section of EP(1001E) is 
where you set payment choices. 

Fees The Fees section of EP(1001E) is 
where you set fee choices. 

Annotate The Annotate section of EP(1001E) is 
where you add notes to the application. 
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12.5 EP(1001E) Menu options 

The EP(1001E) menu allows you to carry out common tasks. The options 
available depend on the circumstances. 

 

Menu  Description 

File Sign  Adds electronic signatures. 

 Save as Ready to 
be Signed 

Moves to the Ready to Sign folder. 

 Save as Draft Saves work so far for later 
completion. 

 Save as 
Template… 

Saves work as a basis for creating 
new forms. 

 Export unpacked 
WAD to... 

Saves all data into XML files which, 
together with all attached document 
files, are stored in a selected 
directory. 

 Export WAD to... Saves all data into XML files which, 
together with all attached document 
files, are stored in a compressed 
ZIP file. 

 Preview Displays the form in PDF format. 

 Close Form Shuts current patent application. 

Edit Undo Reverses last action or clears the 
screen. 

 Copy to Address 
Book Ctrl+C 

In Names section, copies selected 
function to Address Book, without 
opening Address Book. This option 
is only available if information has 
been entered. 

 Delete Ctrl+D In Names section, deletes selected 
entry. This option is only available if 
information has been entered. 

 Note (for EPO) Adds a comment intended for the 
EPO as part of the data submitted. 

 Note (internal) Adds a comment for internal use 
only, not for transmission to the 
EPO. 
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Menu  Description 

View Request Displays the Request section. 

 Names Displays the Names section. 

 States Displays the States section. 

 Priority Displays the Priority section 

 Biological 
Material 

Displays the Biological Material 
section. 

 Contents Displays the Contents section. 

 Payment Displays the Payment section. 

 Fees Displays the Fees section. 

 Annotate Displays the Annotate section. 

Tools Validation Displays validation messages and 
remarks. 

Help Contents  

About epoline® 

Accesses the Help file. 

Displays general information and 
EPO Customer Services details. 
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12.6 EP(1001E) Toolbar options 

EP(1001E) toolbar buttons provide quick access to common tasks.  

 

Button Description 

 
Previews the page. 

 
Prints the page. 

 
Signs the form. 

 
Saves the form as ready to sign. 

 
Displays validation messages. 

 
Opens the Help window. 

 

Move the mouse pointer over a button to see a brief description of what it 
does. If a function is not currently available the button will be dimmed. 
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13 EP(1001E) Request 

The Request section of EP(1001E) is the first one selected when 
preparing a new European patent application. There are three parts to 
the Request section of the application form:  

§ Request for grant 
§ Title of invention 
§ Past record 

 

Request for Grant 

1 Select the Language options you require. 

 

Figure 105: EP(1001E) Request language 

Note To opt out of receiving an extended European search report select 
the option, “Pilot project for EP first filings (ie applications claiming no 
priority): It is requested that no extended European search report be 
drawn up.” 

If you select the check box, Request for examination in admissible 
non-EPO language, the label appears in the corresponding language. 
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If you select Admissible non-EPO language as your language of filing 
option, the list of languages becomes available. 

 

Figure 106: EP(1001E) Selecting language 

 

Title of invention 

1 Type a Title of invention in the language of your choice.  

Please use capital letters only where appropriate.  

You may enter translations for this title. 

Procedural note The title must be a clear and concise technical 
designation of the invention and also be indicated in the other two 
languages for publication in all three official languages (Art. 14 (8) and (9) 
EPC). 

 

 

Figure 107: EP(1001E) Title of invention 
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Past Record 

1 Select any of the options that are relevant. 

 

Figure 108: EP(1001E)  Past Record 

Procedural note For DIVISIONALS see Articles 76(1) and 14(2) and 
Rule 4 EPC.     

To consult the most up-to-date version of the EPC go to the EPC 
website (http://www.european-patent-office.org/legal/epc/). 

Request shortcut menu 

1 Right-click an item to see the shortcut menu.  

You can undo the last action or use the Clipboard to cut, copy or paste 
the text.  

You can also delete the title. 

You can create notes. The notes for all sections are viewable in the 
Annotate section. 
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14 EP(1001E) Names 

The Names section of EP(1001E) is where you supply details of the 
persons involved in this application. You can enter the address for 
correspondence here. Mandatory information in this section is displayed 
in bold typeface. 

For applicants and representatives you have a choice of types of entity. 
For corporate entities enter a name but not a first name. 

 

Function Type of entity Description 

Applicant Legal 

Natural 

A corporate entity (name only) 

Individual (surname and first 
name) 

Representative Association 

Authorised 
representative 

Legal 
practitioner 

A corporate entity (name only) 

Individual (surname and first 
name) 

Individual (surname and first 
name) 

Inventor Natural Individual (surname and first 
name) 

 

14.1 Completing names and details 

1 In the Names section of EP(1001E) select a function and click Open. 
 
You can also double-click the function name: Applicant, 
Representative or Inventor. 
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Figure 109: EP(1001E) Names, List of functions 

 

The corresponding window opens, for example the Applicant window. 

 

14.1 Applicant 

1 Indicate whether the entry is for a Legal person or a Natural 
person.  

2 Enter the Name (in the case of a natural person, the surname). 

The First name and Title options are only available for a natural person. 
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3 Enter your Registration number. Please note that this is essential 
as the registration number facilitates proper allocation to our back 
end system. You can obtain your registration number from the EPO 
Customer Services (p vi). 

4 Enter the remaining details. The Region option depends on the 
country selected. 

5 Enter the telephone and fax numbers as dialled within the country. 
You do not need to add the international dialling code. 

6 Select any appropriate check boxes in the lower part of the form. 

 

Figure 110: EP(1001E) Applicant details 

 

To consult the most up-to-date version of the EPC go to the EPC 
website (http://www.european-patent-office.org/legal/epc/). 

14.1 Representative 

1 Indicate whether the entry is for an Association, an Authorised 
representative or a Legal practitioner.  

2 Enter the Name (in the case of an authorised representative or legal 
practitioner, the surname).  

For an Association the First name and Title options are not available. 
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3 Enter the Registration number and the Authorisation number. 

4 Enter the remaining details. The Region option depends on the 
country selected. 

5 Enter the telephone and fax numbers as dialled within the country. 
You do not need to add the international dialling code. 

 

Figure 111: EP(1001E) Representative details 

 

14.1 Inventor 

1 Enter the Name (ie surname), First name and Title. 

2 Enter the remaining details. The Region option depends on the 
Country selected. 

3 In the set of choices The applicant has acquired the right to the 
European patent as follows: select the appropriate option. 

4 Select the Waiver or Renunciation check boxes in the lower part of 
the form as appropriate.  
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Figure 112: EP(1001E) Inventor details 

 

Note If the Waiver or Renunciation check boxes are selected, the 
appropriate file references are displayed automatically in the EP(1001E) 
Contents section, on the Forms tab. The waiver is saved during the 
submission process as EPR17301.PDF and the renunciation is saved as 
EPR18301.PDF. 

 

Figure 113: EP(1001E) Contents, Forms tab, Waiver and Renunciation 
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Adding additional names 

To add additional applicant names click the +Applicant option, and then 
click the Open button. As you add applicants, the system numbers them 
in order. To add additional representatives click the + Representative 
option. To add additional inventors click the + Inventor option. 

 

Deleting names 

1 In the EP(1001E) Names section, right-click a name. 

2 In the shortcut menu select Delete. 

 

Names shortcut menu 

Right-click an item in the Names section of EP(1001E) to see the menu. 
You can copy the name to the Address Book or delete it. You can also 
add notes. The notes for all sections are viewable in the Annotate 
section. 
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15 EP(1001E) States 

The States section of EP(1001E) is where you designate the countries in 
which you require patent protection. You may also select participating 
extension states. 

Procedural note The list of states is valid as of the last maintenance 
data update. Live Update provides a service for updating the Online 
Filing software itself, plus the maintenance and fees data. The Live 
Update option is located in File Manager Tools, Settings. 

To designate contracting states: 

1 Double-click Designation. 

 

Figure 114: EP(1001E) Designation of states 

 

To consult the most up-to-date version of the EPC go to the EPC 
website (http://www.european-patent-office.org/legal/epc/). 
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The Designation of states window opens. 

 

Figure 115: EP(1001E) Designation of states 
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1 Select either the option for all states or the option for fewer than 
seven states. 

2 If appropriate, double-click Extension. 

The Extension fees window opens. 

 

Figure 116: EP(1001E) States, Extension fees 

 

3 Select the option for all states, or specify the ones you require. 

 

States shortcut menu 

Right-click an item in the States section of EP(1001E) to see the shortcut 
menu. You can undo an action or add notes. The notes for all sections 
are viewable in the Annotate section. 
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16 EP(1001E) Priority 

The Priority section of EP(1001E) is where you specify details of the 
priority application you wish to claim.  

 

To claim a priority: 

1 Double-click Open to add new item. 

 

Figure 117: EP(1001E) Declaration of priorities 

 

The Priority window opens. 

 

Figure 118: EP(1001E) Priority details 
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Procedural note To complete the priority claim, unless otherwise 
excluded by decision of the President of the EPO (OJ EPO 1999, 80), a 
certified copy of the previous application containing the original of the 
certificate as issued by the receiving authority must be submitted within 
sixteen months of the earliest priority date (Rule 38(3) EPC). 

The application must be filed within one year of the claimed priority. 

16.1 National priority 

1 Select an option from the National office list. 

2 Select a priority from the Kind list. 

3 Enter the Filing date. 

4 Enter the Application number. 

 

Figure 119: National priority, sample data 

 

Once a kind of priority is selected, it is indicated in the Priority section. 
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If appropriate select the check box It is hereby declared that the 
application is a complete translation of the previous application 
(Rule 38(5)) in the lower part of the form. 

 

Figure 120: EP(1001E) Kind of priority displayed 
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16.1 Regional priority 

1 Select an option from the Regional office list. 

2 Select a priority from the Kind list. 

3 Enter the Filing date. 

4 Enter the Application number. 

 

Figure 121: EP(1001E) Regional priority, sample data 

 

16.1 International priority 

1 Select an option from the Filing office list. 

2 Select a priority from the Kind list. 

3 Enter the Filing date. 

4 Enter the Application number. 
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Figure 122: EP(1001E) International priority, sample data 
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16.1.1 Sorting priorities 
Where more than one priority claim has been added, the Sort priority 
claims chronologically option becomes available in the shortcut menu. 

 

Figure 123: EP(1001E) Sorting priorities chronologically 

 

16.1.1 Adding translations 
1 In the EP(1001E) Contents section, Other Documents tab, select 

Translation of priority documents from the list and then click Add. 

 

Figure 124: EP(1001E) adding translations of priority documents 
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2 Double-click the new item, Translation of priority documents. 

 

Figure 125: EP(1001E) Opening Translation of priority documents 

 

3 Type a comment in the Details box if you wish. 

4 Click the Browse button and attach the document. 

 

Figure 126: EP(1001E) Attaching translation of priority documents 
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Priority shortcut menu 

Right-click an item in the Priority section of EP(1001E) to see the 
shortcut menu. If you have created more than one entry in the Priority 
section, you can sort the priority claims chronologically. You can also add 
notes. The notes for all sections are viewable in the Annotate section. 
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17 EP(1001E) Biological Material 

The Biological Material section of EP(1001E) is where you input details 
of the depositary institution. Once you have entered the information you 
can copy it to the Receipt Book. 

To input details of deposit of biological material: 

1 In the EP(1001E) Biological Material section, double-click Open to 
add new item. 

 

Figure 127: EP(1001E) Deposit of biological material 

 

To consult the most up-to-date version of the EPC go to the EPC 
website (http://www.european-patent-office.org/legal/epc/). 

 

The Biological Material window opens. 
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1 Type an identification reference. 

2 Select an option from the Depositary Institution list. 

3 Type an accession number. 

4 Select the check boxes for any additional information as appropriate. 

 

Figure 128: EP(1001E) Depositary institution 

 

Note If you select the check box Waiver of right to undertaking from 
requester (Rule 28(3) EPC), a new item is added to the Contents 
section, Other Documents tab. For more information see EP(1001E) 
Contents, Other documents tab (p 51). 

If you select the check box Deposit by a person other than the 
applicant, the Additional information window opens.  

1 Complete the name and address of the other person. 
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Figure 129: EP(1001E) Deposit by person other than applicant 

 

17.1 Attaching receipts for biological material 

Once you complete the details for the deposit of biological materials, the 
Contents section, Other Documents tab of EP(1001E) displays a new 
document type: Receipt(s) of deposit (biological material).  

To attach the electronic copy of the receipt: 

1 In the EP(1001E) Contents section, click Other Documents. 

2 Double-click Receipt(s) of deposit (biological material). 

 

Figure 130: EP(1001E) Opening receipt(s) 

 

The Documents window opens 
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3 With Receipt(s) of deposit (biological material) selected on the 
left, click the Browse button and attach the document. 

 

Figure 131: Attaching receipt(s) of deposit (biological material) 

 

The file is renamed to BIOM-1.PDF. This name is for internal processing 
only, and the original file is not modified at all. 

 

Figure 132: Receipt for biological material renamed 

 

17.1 Removing receipts 

1 In the EP(1001E) Contents section, Other Documents tab, 
Documents window, with Receipt(s) of deposit (biological 
material) selected on the left, click Reset. 

The attached document is removed. 
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Note The original document is not changed.  

 

Figure 133: Removing receipt of deposit 

 

Biological material shortcut menu 

Right-click an item in the Biological Material section of EP(1001E) to 
see the shortcut menu. You can Undo, Delete or Copy deposit 
information. You can add notes. The notes for all sections are viewable in 
the Annotate section. 
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17.2 EP(1001E) Nucleotide and amino acid 
sequences 

1 In the EP(1001E) Biological Material section, select the option for 
nucleotide and amino acid sequences if appropriate.  

 

Figure 134: Nucleotide and/or amino acid sequence listing 

 

This automatically adds two document headings to the Contents section, 
Technical Documents tab: 

§ Sequence Listings, PDF 
§ Sequence Listings, ASCII 

Sequence Listings, ASCII has a file extension of TXT. 

Procedural note Both sequence listings are mandatory. The sequence 
listing in PDF format must be provided with the filing. The sequence 
listing in ASCII format may be provided subsequent to filing. 
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17.3 EP(1001E) Attaching sequence listings 

To attach the mandatory documents: 

1 In the EP(1001E) Contents section, Technical Documents tab, 
double-click a Sequence Listing option. 

 

Figure 135: EP(1001E) Contents, Sequence listings added 

 

The Documents window opens. 
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2 Browse to the file location and attach the document. 

 

Figure 136: EP(1001E) Attaching sequence listing, PDF 

 

 

The file is renamed to SEQLPDF.PDF. This name is for internal 
processing only, and the original file is not modified at all. 

 

Figure 137: Sequence listing PDF renamed 

 

 

1 Repeat this process to attach the sequence listing in ASCII format. 

The file is renamed to SEQLTXT.TXT.  

 

Figure 138: Sequence listing TXT renamed 
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18 EP(1001E) Contents 

The Contents section of EP(1001E) is where you attach the documents 
which support your patent application. Attached documents are copies of 
the original. If the original changes and you wish to include the changes 
in the patent application, you will need to reattach it. 

The Contents section of EP(1001E) has three tabs: 

§ Forms 
Forms attached automatically. 
§ Technical Documents 
Mandatory documents attached to support the patent application.  
§ Other Documents 
Additional information that may be attached to the patent application. 

 

 

Figure 139: Contents section, opening view 
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18.1 Document preparation 

Note The EPO can only accept documents prepared with the correct 
settings. The key points to remember are: 

§ Correct fonts must be chosen in order to display information correctly, 
including characters such as mathematical formulae and Greek 
characters. 

§ Paper size must be A4. 
§ Page orientation must be Portrait. 

Portable Document Format hints and tips (p 275) 
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18.2 EP(1001E) Contents, Forms tab 

The Forms tab of EP(1001E) contains the following documents as 
standard. 

 

Form Description 

Requests The current patent application EP(1001E) 
The system prepares this in Portable 
Document Format and names it 
EPF1001.PDF. 

Fee settlement Reserved for future development. 

Validation log A summary of validation messages. 

 

 

Figure 140: EP(1001E)  Contents, Forms 

 

Other documents may appear in the list, depending on the options 
selected. 
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18.3 EP(1001E) Contents, Technical 
documents tab 

The Technical Documents tab of EP(1001E) is where the documents 
supporting the patent application are attached. These documents can be 
prepared in PatXML or PDF format. 

§ PatXML 
A PatXML document is a combined file called Application body. It 
contains the description, claims, abstract and drawings. The starting and 
ending pages for each section are calculated automatically. 
§ PDF  
PDF documents can be attached as separate files or as a combined file. 

 

Note If you select a different option after attaching documents, the 
documents are automatically removed from the current form. The original 
documents are not changed.  

 

 
 

18.3.1 PatXML attachments 
1 In the Contents section, select the option PatXML attachments. 

2 Double-click Application body. 

 

Figure 141: PatXML attachments 

 

The Documents window opens. 



 

 EP(1001E) Contents 43 
 

3 Enter the number of claims. 

4 If appropriate, enter the number of figures and the figure to be 
published with abstract. 

5 Click the Browse button and attach the relevant document.  

 

Figure 142: PatXML Attaching Application body 

 

This document is attached automatically and named application-
body.xml. 

The beginning and ending page numbers for the description, claims, 
abstract and drawings are entered automatically. The total number of 
pages is calculated automatically. 

 

 
 

18.3.2 Attaching separate PDF files 
As a minimum the description and claims must be attached. The 
number of claims and the abstract are mandatory but may be provided 
subsequent to filing. 

1 In the EP(1001E) Contents section, select the option PDF 
documents. 

2 Double-click a document type to open the Documents window. 

3 In the Documents window click the Browse button and attach the 
document. 
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18.3.3 Attaching description 
1 In the Contents section, Technical Documents tab, select the 

option PDF attachments. 

2 Double-click Description to open the Documents window. 

 

Figure 143: Description 
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3 With Description selected on the left, click the Browse button. 

 

Figure 144: EP(1001E) Attaching description 

 

4 Navigate to the folder where the Description document is filed. 

5 Select the relevant document and click Open. 

The file is renamed to DESC.PDF. This name is for internal processing 
only, and the original file is not modified at all. 

 

Figure 145: Description file renamed 
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18.3.4 Attaching claims 
1 In the Contents section, Technical Documents tab, select the 

option PDF attachments. 

2 Double-click Claims to open the Documents window. 

3 With Claims selected on the left, enter the number of claims. 

4 Click the Browse button. 

 

Figure 146: Attaching claims 

 

5 Navigate to the folder where the Claims document is filed. 

6 Select the relevant document and click Open. 

The file is renamed to CLMS.PDF. This name is for internal processing 
only, and the original file is not modified at all. 

 

Figure 147: Claims file renamed 
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18.3.5 Attaching drawings 
1 In the Contents section, Technical Documents tab, select the 

option PDF attachments. 

2 Double-click Drawings to open the Documents window. 

3 With Drawings selected on the left, enter the number of figures. 

4 Click the Browse button. 

 

Figure 148: Attaching drawings 

 

5 Navigate to the folder where the Drawings document is filed. 

6 Select the relevant document and click Open. 

The file is renamed to DRAW.PDF. This name is for internal processing 
only, and the original file is not modified at all. 

 

Figure 149: Drawing file renamed 
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18.3.6 Attaching abstract 
1 In the Contents section, Technical Documents tab, select the 

option PDF attachments. 

2 Double-click Abstract to open the Documents window. 

3 With Abstract selected on the left, enter the figure to be published 
with abstract if required. 

4 Click the Browse button. 

 

Figure 150: Attaching abstract 

 

5 Navigate to the folder where the Abstract document is filed. 

6 Select the relevant document and click Open. 

The file is renamed to ABST.PDF. This name is for internal processing 
only, and the original file is not modified at all. 

 

Figure 151: Abstract file renamed 
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18.3.7 Attaching combined PDF file 
1 In the Contents section, select the option PDF attachments. 

2 Select the check box Combined file for abstract, claims, 
description. 

3 Double-click Specification to open the Documents window. 

 

Figure 152: Contents, Combined specification 

 

4 In the Documents window enter the number of claims. 

5 Enter a figure to be published with abstract if appropriate. 

6 Click the Browse button and attach the specification file. 

 

Figure 153: EP(1001E) Contents, attaching specification 

 

The total number of pages is calculated automatically. 
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7 Enter the starting and ending page numbers for each section. 

Sections must not overlap, and all pages must be accounted for. 

 

Figure 154: Entering page numbers for combined specification 

 

Note In the Contents section, click the Validation button to see any 
explanatory messages.  

 
In the example below, the validation message indicates that a mistake 
was made when entering the page numbers for the combined file 
specification. Overlapping page numbers are not allowed in the combined 
specification sections and all pages must be accounted for. 

 

Figure 155: Contents, Validation Messages 
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18.4 EP(1001E) Contents, Other Documents tab 

The Other Documents tab does not contain any mandatory documents. 
However, you can add documents to this tab. First select the kind of 
document you require, and then attach the file. 

Note With Online Filing version 2.10SP2 you may now attach digitally 
certified US priority documents. In the list of document types select 
OTHER and the option US priority document in electronic format, and 
then follow the instructions. 

However, it is recommended that this feature is not used with Acrobat 
Reader version 4 as the document can neither be viewed in Online Filing 
nor opened with the Acrobat reader. Later versions of the Acrobat Reader 
may be used. 

 

1 In the EP(1001E) Contents section, Other Documents tab, select a 
type of document and click Add. 

 

Figure 156: EP(1001E) Contents, Other Documents tab, Translation 

 

The document item is added to the Checklist of submitted documents 
and files. 
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2 Double-click the document item to open the Documents window. 

 

Figure 157: EP(1001E) Opening translation of priority documents 
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3 In the Documents window, type any Details you require. 

4 Click the Browse button and attach the document. 

 

Figure 158: EP(1001E) Attaching translation of priority document 

 

18.4.1 Adding document type OTHER 
1 In the EP(1001E) Contents section, Other Documents tab, select 

the document type OTHER and click Add. 

 

Figure 159: EP(1001E) Selecting document type OTHER 
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The word <specify> appears. 

 

Figure 160: Document type OTHER, specify 

 

2 Type a name for the document and click Add. 

 

Figure 161: Document type OTHER, sample data 

 

3 Double-click the document item to open the Documents window. 

 

Figure 162: Opening document item, sample data 
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4 In the Documents window, type any Details you require. 

5 Click the Browse button and attach the document. 

 

Figure 163: Attaching document type OTHER, sample data 

 
 

18.4.2 Removing attachments 
1 In the Contents section, double-click the document you wish to 

remove to open the Documents window 

2 With the document selected, click Reset.  

The attachment is removed. 

 

Figure 164: Removing attachments 

 

Note Only the copy attached to the patent application is removed. The 
original document is not affected. 
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19 EP(1001E) Payment 

The Payment section of EP(1001E) is where you specify the mode of 
payment and give details of the account number and account holder.  

 

Figure 165: EP(1001E) Payment 

 

To specify the payment details: 

1 Select an option from the Mode of payment list. 

 

Figure 166: EP(1001E) Payment, modes 

 

Depending on the Mode of payment selected, additional options are 
displayed for completion. 
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For options requiring an account number, the number must consist of 
eight digits, starting with 28. 

2 Complete any further options. 

 

Payment shortcut menu 

Right-click an item in the Payment section of EP(1001E) to see the 
shortcut menu. You can undo the last action or use the Clipboard to 
copy or paste text. You can also create notes. The notes for all sections 
are viewable in the Annotate section. 
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20 EP(1001E) Fees 

The Fees section of EP(1001E) is where fees associated with the 
submission are calculated.  

The Fees section has three tabs: 

§ Standard Fees 

Fees normally associated with an EP(1001E) patent application, for 
example, Filing, Search and Claims. 
§ Other Fees 
Priority document and subsequent renewal fees. 
§ Additional Fees 
All non-standard fees. 

The fees displayed in the Fees section of EP(1001E) depend on the 
option you chose in the Payment section. The fee information is held in 
File Manager, Tools, Maintenance. You can only view it here. Fee 
schedules are located in the File Manager, Tools, Maintenance. Live 
Update provides a service for updating the Online Filing software itself, 
plus the maintenance and fees data. The Live Update option is located in 
File Manager Tools, Settings. 

 

Fees shortcut menu 

Right-click an item in the Fees section of EP(1001E) to see the shortcut 
menu. You can add notes. The notes for all sections are viewable in the 
Annotate section. 

 

 

 
 

20.1 EP(1001E) Fees, Standard Fees tab 

1 In the EP(1001E) Fees section, click the Standard Fees tab. 

2 Select the date from the Fee schedule for EUR valid as of: list. 

The standard fees and their descriptions are listed, with the relevant 
options selected.  
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The total amount due is displayed in the lower part of the form. 

 

Figure 167: EP(1001E) Fees, Standard Fees tab 

 
 

20.2 EP(1001E) Fees, Other Fees tab 

1 In the EP(1001E) Fees section, click the Other Fees tab. 

2 Select a date from the Fee schedule for EUR valid as of: list. 

3 Select the check boxes for the fees you wish to see. 

The amounts are imported from the fee schedule. 
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The total amount due is displayed in the lower part of the form. 

 

Figure 168: EP(1001E) Other Fees, selecting date 

 
 

20.3 EP(1001E) Fees, Additional Fees tab 

1 In the EP(1001E) Fees section, click the Additional Fees tab. 

2 Select the date from the Fee schedule for EUR valid as of: list. 

3 Select the check boxes for the fees you wish to see. 

The fees are displayed. 
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The total amount due is displayed in the lower part of the form. 

 

Figure 169: EP(1001E) Fees, Additional Fees tab 

 

Note The Additional Fees option is targeted for future development. 
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21 EP(1001E) Annotate 

The Annotate section is where you can see all the notes that have been 
made for this application. You can also add notes here. A note (for EPO) 
is a comment intended for those receiving the application as part of the 
data submitted. A note (internal) is for internal use only and is not 
transmitted to the EPO. 

21.1 Adding notes 

1 In the Annotate section select a type of note and click Add. 

 

Figure 170: Adding a note 

 

The Note window opens. 
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2 Type the information you require. 

You can also add notes from the shortcut menus of other sections. 

 

Figure 171: Annotate, completing note details 
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21.1.1 Deleting notes 
1 In the Annotate section, click a note to select it. 

2 Right-click the note to display the shortcut menu. 

3 In the shortcut menu select Cut. 

Note This operation cannot be undone. 

 

21.1 Validation log 

The Annotate section contains the Validation log of all the validation 
messages for the application. You can access the individual messages 
from the menu for each section. 

1 To display individual validation messages related to completing the 
form correctly, click the Validation button in the sections. 

 

Figure 172: Validation button 
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Validation messages are displayed for the current section. 

 

Figure 173: Sample validation messages for EP(1001E), Contents 

 

1 In the EP(1001E) Annotate section, double click Validation log to 
see the entire list. 

 

Figure 174: Validation log 

 

The validation log opens. 
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2 Scroll through the list to see all the messages. 

 

Figure 175: Viewing validation log 

 

Note In addition to checking individual sections, the system also carries 
out global validation, that is, it cross-checks the overall correctness of 
the patent application. For example, if in the Biological Material section 
you select the option to include a sequence listing, in the Contents 
section the traffic light remains red until you attach the mandatory 
document.  
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22 EP(1038E) Overview 

EP(1038E) is the name given to the form used in the European patent 
procedure to submit documents filed subsequently to an application. The 
form has been designed to allow you to: 

§ Add applicant and representative information. 
§ Submit additional documents after the patent application has been 

sent. 

EP(1038E) is organised into four sections to help you process your form. 

Section Comments 

Request Enter the application number. 

Names Add applicant and representative details. 

Contents Attach documents subsequent to filing. 

Annotate Add notes and check the validation log. 

 

When you click a section to select it, the options for that section are 
displayed. These represent the types of information you need to complete 
in order to submit subsequently filed documents. The EP(1038E) form 
also contains a menu and a toolbar.  

As you complete the form, two features will help you decide whether the 
information you have entered is complete and correct: 

For more information see Traffic lights (p 235) and Validation 
messages (p 235). 
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22.1 EP(1038E) Sections 

 EP(1038E) consists of four sections. 

 

Section Comments 

Request Enter the application number. 

Names Add applicant and representative details. 

Contents Attach documents subsequent to filing. 

Annotate Add notes and check the validation log. 

 
 

22.2 EP(1038E) Menu options 

The menu allows you to carry out common tasks. The options available 
depend on the circumstances. 

 

Menu  Description 

File Sign  Add electronic signatures. 

 Save as Ready to 
Sign 

Move to the Ready to Sign folder. 

 Save as Draft Save work so far for later completion. 

 Save as Template Save work as a basis for creating new 
forms. 

 Export unpacked 
WAD to 

Save as XML. 

 Export WAD to Save as XML in compressed ZIP format. 

 Preview Display the form in PDF format. 

 Print Print the current form. 

 Close Form Shut current form. 

View Request Display the Request section. 

 Names Display the Names section. 

 Contents Display the Contents section. 
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Menu  Description 

 Annotate Display the Annotate section. 

Tools Validation See validation messages and remarks. 

Help Contents  

About  

Access the Help file. 

Display general information and EPO 
Customer Services details. 

 
 

22.3 EP(1038E) Toolbar options 

Toolbar buttons provide quick access to common tasks.  

 

Button Description 

 
Previews the page. 

 
Prints the page. 

 
Signs the form. 

 
Saves the form as ready to sign. 

 
Opens the Help window. 

 
Validation. 

 

Place your mouse pointer over a button to see a brief description of what 
it does. If a function is not currently available the button will be dimmed. 
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23 Creating new EP(1038E) forms 

1 In File Manager select New Form, EP(1038E) from the File menu. 

 

Figure 176: Creating a new EP(1038E) form 

 

You can also create a new form in File Manager by double-clicking the 
template named EP(1038E).  
The Subsequently Filed Documents - EP1038E window opens. 

2 Select an option from the language of proceedings list. 

3 Type a user reference. 

This reference must be unique. It is the name of this form. 

4 If you wish, select the option to use File Manager categories.  

Categories allow you to group forms in a way that is meaningful to your 
organisation, for example, by type of content or department.  

Forms can then be sorted and displayed by category. 
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5 If you select the categories option, type a name in the Create new 
category box, and then click Add. 

Or select an option from the list of existing categories. 

 

Figure 177: EP(1038E) Adding a category, sample data 
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24 EP(1038E) Request 

The Request section of EP(1038E) is the first one selected in a new 
form. There is one part to the Request section of the form:  

§ Application number 

 

1 Enter your EP application number in the area provided.   

The applicant's or representative's reference is the reference entered 
when this form was created. 

 

 

Figure 178: EP(1038E) Request, application number 

 
 



 

     EP(1038E) Names 73 
 
 

25 EP(1038E) Names 

Use the Names section to add applicant or representative information, 
or to specify the address for correspondence. To save retyping you can 
add names from the Address Book or you can save the new details to the 
Address Book for future use. 

25.1 Adding applicants 

1 In the Names section double-click +Applicant. 

You can also select +Applicant and click Open. 

 

 

Figure 179: EP(1038E) Names, opening applicant 

 

2 The Applicant details window opens. 

3 Select either Legal person or Natural person. 

4 Enter the registration number. 

Please note that this is essential as the registration number facilitates 
proper allocation to our back-end system. You can obtain your 
registration number from EPO Customer Services (p vi). 
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5 Type the details you require. 

Mandatory information is displayed in bold. 

6 If appropriate select the Address for correspondence check box. 

 

 

Figure 180: EP(1038E) Names, applicant details 

 

To consult the most up-to-date version of the EPC go to the EPC 
website (http://www.european-patent-office.org/legal/epc/). 

Note To add another applicant, click +Applicant. 

 

25.1 Adding representatives 

1 In the Names section double-click +Representative. 

You can also select +Representative and click Open. 
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The Representative details window opens. 

 

Figure 181: EP(1038E) Names, representative details 

 

2 Select either Association, Authorised representative or Legal 
practitioner. 

3 Enter the registration number and authorisation number. 
 
Please note that this is essential as the registration number facilitates 
proper allocation to our back end system. You can obtain your 
registration number from EPO Customer Services (p vi). 

4 Type the details you require. 

 

Note To add another representative, click +Representative. 
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26 EP(1038E) Contents 

To submit a subsequently filed document relating to an EP or Euro-PCT 
application go the EP(1038) Contents section. The Contents section has 
two tabs: 

 

Forms The electronic file name for the request is 
displayed (EPF1038E.PDF). 

Other Documents Two lists are provided, the first to select the 
document category and the second to select a 
document type within the category. Once the 
category and document type are selected the 
Add button becomes available so that you can 
attach the document. 

 

26.1 Document preparation 

The EPO can only accept documents prepared with the correct settings. 
The key points to remember are: 

§ Correct fonts must be chosen in order to display information correctly, 
including characters such as mathematical formulae and Greek 
characters. 

§ Paper size must be A4. 
§ Page orientation must be Portrait. 

Portable Document Format hints and tips (p 275) 

Note Document names may not contain spaces. You can add more than 
one document of the same type. Each one is given the next number up 
as you add it. The total number of documents is displayed below the 
checklist. The documents must be in Portable Document Format, 
except for the document concerning sequence listing which may be 
attached both in TXT format and in PDF format if you so wish.  

26.1 EP(1038E) Selecting documents 

Note With Online Filing version 2.10SP2 you may now attach digitally 
certified US priority documents. In the Priorities group select the option 
US priority document in electronic format, and then follow the 
instructions. 
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However, it is recommended that this feature is not used with Acrobat 
Reader version 4 as the document can neither be viewed in Online Filing 
nor opened with the Acrobat reader. Later versions of the Acrobat Reader 
may be used. 

1 In the Other Documents tab, Checklist of submitted documents 
and files click the first drop-down arrow. 

2 Select the appropriate document category. 

 

Figure 182: EP(1038E) Contents, selecting category 
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3 Click the next drop-down arrow and select the specific document. 

4 Click Add. 

 

Figure 183: EP(1038E) Contents, selecting specific document 

The item name is added to the checklist. 

5 Double-click the item name. 

 

Figure 184: EP(1038E) Opening "amendments before examination" 

 

The Document details window opens. 
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6 Click the Browse button, navigate to the file location and attach the 
document. 

 

Figure 185: EP(1038E) Attaching "amendments before examination" 

 

To remove the attachment click Reset. 

The Checklist of submitted documents and files displays the attached 
documents and their electronic file names. These electronic file names 
are used by the EPO back-end systems to process your submission. You 
should always select carefully and try to match the category and 
document as specifically as possible to your requirements.  

Note If you are unsure which document type to choose, and only in 
exceptional circumstances, please select the category Others and the 
document type Letter relating to search and examination procedure, 
as this is a generic document type.  

The total number of documents is calculated in the lower part of the form. 
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Figure 186: EP(1038E) Contents, document added to checklist 

 

Note To see the entire list of documents, select All categories. 

 

Figure 187: EP(1038E) All categories 

 

Scroll through the list of documents and select the one you require. 
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Figure 188: EP(1038E) List of documents in all categories 

 
 

26.2 EP(1038E) Document types 

When you submit a subsequently filed document relating to an EP or 
Euro-PCT application (1038E) you have the following categories and 
document types to choose from. 

 

Categories Document types 

Amendments Amendments before examination 

 Modified abstract 

 Drawings 

 Amended claims 

 Amended drawings 

 Amended description 

Biology Document concerning sequence listing 

 Document concerning micro-organisms and 
medical inventions 
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Categories Document types 

Fees Document concerning the designation and 
extension of states 

 Document concerning fees and payments 

 Automatic debiting 

Forms Designation of inventor 

 Authorisation of representative 

Inventor Documents concerning the inventorship 

Legal Remedies Request for further processing 

 Request for restitutio in integrum 

 Grounds for restitutio in integrum 

 Request for a decision 

Others Letter relating to the search and examination 
procedure 

 Document filed during Examination procedure 

 Document concerning search matters 

 Translation of the international preliminary 
examination report 

 Letter dealing with oral proceedings 

 Withdrawal of a request for oral proceedings 

Priorities Translation of priority document 

 US priority document in electronic format 

 Document concerning the priority claims 

Replies Reply to examination report 

 Request for extension of time limit during 
examination procedure 

 Reply to the communication under rule 51(4) EPC 

 Request for correction after communication under 
rule 51(4) EPC 

 Claims 

 Translation of claims 
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Categories Document types 

Representative Document concerning representation 

Requests Request for accelerated search/examination 

 Request for examination 

 Request for suspension/interruption of the 
procedure 

 General enquiry 

 Request for correction of the documents 

 Maintenance of the application 

 Request for certified copies of the application 

 Request for extension of time limit during search 
procedure 

 Request for transfer of rights 

 Request for assignment 

 Request for change of address 

 Request for change of name 

 Request for change of representative 

Withdrawals Withdrawal of an application 

 Withdrawal of designated or extension states 

 

 

 
 

26.3 Exclusions 

 The following document type may NOT be submitted via the 
EP(1038E) Subsequently Filed Documents form: 

§ Documents relating to oppositions and appeals. 
§ Priority document apart from digitally certified US priority documents.  

EP(1038E) may not be used for the PCT patent grant procedure. 
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27 EP(1038E) Annotate 

The Annotate section is where you can see all the notes that have been 
made for this form. You can also add notes here. A note (for EPO) is a 
comment intended for the EPO, as part of the data submitted. A note 
(internal) is for internal use only and is not transmitted to the EPO. 

27.1 Adding notes 

1 In the Annotate section select a type of note and click Add. 

 

Figure 189: Adding a note 

 

The Note window opens. 
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2 Type the information you require. 

You can also add notes from the shortcut menus of other sections. 

 

Figure 190: Annotate, completing note details 
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27.1.1 Deleting notes 
1 In the Annotate section, click a note to select it. 

2 Right-click the note to display the shortcut menu. 

3 In the shortcut menu select Cut. 

Note This operation cannot be undone. 

 

27.1 Validation log 

The Annotate section contains the validation log of all the validation 
messages for the form. You can access the individual messages from the 
menu for each section. 

1 To display individual validation messages related to completing the 
form correctly, click the Validation button in the sections. 

 

Figure 191: Validation button 
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Validation messages are displayed for the current section. 

 

Figure 192: EP(1038E) Validation messages 

 

2 In the EP(1038E) Annotate section, double click Validation log to 
see the entire list. 

 

Figure 193: Validation log 

 

The Validation log opens. 
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3 Scroll through the list to see all the messages. 

 

Figure 194: EP(1038E) Viewing validation log 
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28 Euro-PCT(1200E) Overview 

Euro-PCT(1200E) is the electronic equivalent of Form 1200. Euro-
PCT(1200E) allows you to submit Patent Cooperation Treaty (PCT) 
applications electronically. It is used for entry into the regional phase 
before the EPO as designated or elected office. 

Euro-PCT(1200E) is organised into several parts to help you process 
your form: menu, toolbar and sections. When you click a section to 
select it, the options for that section are displayed. These represent the 
types of information you need to complete for the Euro-PCT(1200) form. 

As you prepare the form, two features will help you decide whether the 
information is complete and correct: 

For more information see Traffic lights (p 235) and Validation 
messages (p 235). 

 
 

28.1 Creating new Euro-PCT(1200E) forms 

1 In File Manager select New Form, Euro-PCT(1200E) from the File 
menu. 

 

Figure 195: Creating a new form, Euro-PCT(1200E) 

 

You can also create a new form in File Manager by double-clicking the 
template named Euro-PCT(1200E).  
The New application window opens. 

2 Select an option from the Language of the proceedings list. 

3 Enter a user reference.  

This reference must be unique. It is the name of this Euro-PCT(1200) 
form. 

4 Select the option to use File Manager categories if you wish.  

Categories allow you to group forms in a way that is meaningful to your 
organisation, for example by type of content or department. Forms can 
then be sorted and displayed by category. 
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28.2 Euro-PCT(1200E) Sections 

Section Comments 

EP Phase The EP Phase section of Euro-
PCT(1200E) is where you officially 
request examination of the application 
under Article 94 EPC, enter the applicant 
or representative reference and note 
previous application or publication 
numbers.  

Names The Names section of Euro-PCT(1200E) 
is where you note any changes to 
applicant details. You can also add an 
address for correspondence or a new 
representative. 

States The States section of Euro-PCT(1200E) 
is where you designate the countries in 
which you require patent protection. You 
may also select extension states. 

Biological Material The Biological Material section of Euro-
PCT(1200E) is where you input details of 
biological material filed if relevant and 
name the depositary institution. 

Documents The Documents section of Euro-
PCT(1200E) is where you confirm that the 
documents submitted to the International 
Bureau are the same ones being 
submitted here.  

Translations The Translations section of Euro-
PCT(1200E) is where you list the 
translations supplied in one of the official 
languages of the European Patent Office. 

Contents The Contents section of Euro-
PCT(1200E) is where you attach 
documents to accompany the submission.  

Payment The Payment section of Euro-
PCT(1200E) is where you specify the 
mode of payment and give details of 
account number and account name. 

Fees The Fees section of Euro-PCT(1200E) is 
where fees associated with the 
submission are calculated. 
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Section Comments 

Annotate The Annotate section is where you can 
see all the notes that have been made for 
this Euro-PCT(1200) form. The Annotate 
section also contains the validation log 
with all the validation messages for the 
Euro-PCT(1200) form. 

 

 
 

28.3 Euro-PCT(1200E) Menu options 

The Euro-PCT(1200E) menu allows you to carry out common tasks. The 
options available depend on the circumstances. 

 

Menu  Description 

File Sign  Adds electronic signatures. 

 Save as Ready 
to be Signed 

Saves Euro-PCT(1200) form in 
the Ready to Sign folder. 

 Save as Draft Saves work so far for later 
completion. 

 Save as 
Template 

Saves work as a basis for 
creating new forms. 

 Export 
unpacked WAD 
to... 

Saves all data into XML files 
which, together with all attached 
document files, are stored in a 
selected directory. 

 Export WAD 
to... 

Saves all data into XML files 
which, together with all attached 
document files, are stored in a 
compressed ZIP file. 

 Preview Displays the form in PDF format. 

 Close Form Shuts current Euro-PCT(1200) 
form. 
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Menu  Description 

Edit Undo Reverses last action or clears the 
screen. 

 Copy to 
Address Book 
Ctrl+C 

In the Names section, copies 
selected function to Address 
Book, without opening Address 
Book. This option is only available 
if information has been entered. 

 Delete Ctrl+D In the Names section, deletes 
selected entry. This option is only 
available if information has been 
entered. 

 Note (for EPO) Adds a comment intended for 
EPO, as part of the data 
submitted. 

 Note (internal) Adds a comment contained in the 
form in preparation only, not for 
transmission to the EPO. 

View EP Phase Displays the EP Phase section. 

 Names Displays the Names section. 

 States Displays the States section. 

 Biological 
Material 

Displays the Biological Material 
section. 

 Documents Displays the Documents section. 

 Translations Displays the Translations section. 

 Contents Displays the Contents section. 

 Payment Displays the Payment section. 

 Fees Displays the Fees section. 

 Annotate Displays the Annotate section. 

Tools Validation Displays validation messages and 
remarks. 

Help Contents 

About 
epoline® 

Accesses the Help file. 

Displays general information and 
EPO Customer Services details. 

 
 



 

     Euro-PCT(1200E) Overview 93 
 
 

28.4 Euro-PCT(1200E) Toolbar options 

Euro-PCT(1200E) toolbar buttons provide quick access to common tasks. 

 

Button Description 

 
Previews the page. 

 
Prints the page. 

 
Signs the form. 

 
Saves the form as ready to sign. 

 
Displays validation messages. 

 
Opens the Help window. 

 

Move the mouse pointer over a button to see a brief description of what it 
does. If a function is not currently available the button will be dimmed. 
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29 Euro-PCT(1200E) EP Phase 

The EP Phase section of Euro-PCT(1200E) is where you officially 
request examination of the application under Article 94 EPC, enter the 
applicant or representative reference and note previous application or 
publication numbers.  

EP Phase contains two sections for entering data: 

1 Entry into the European phase (EPO as designated or elected Office) 

2 Past Record 

29.1 Entry into the European phase 

1 In the Euro-PCT(1200E) EP Phase section, select the check box 
Request examination in an admissible non-EPO language if 
appropriate. 

If this option is selected, the list of languages on the right becomes 
available. 

2 Select a language from the drop-down list.  

 
 

 

To consult the most up-to-date version of the EPC go to the EPC 
website (http://www.european-patent-office.org/legal/epc/). 

29.1 Past Record 

1 Select the check box PCT application number and enter the 
number from the previous application. 

This information is mandatory.  
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2 If appropriate enter the other numbers. 

 

Figure 196: Euro-PCT(1200E)  Past Record 
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30 Euro-PCT(1200E) Names 

The Names section of Euro-PCT(1200E) is where you note any changes 
to applicant details. You can also add an address for correspondence or 
a new representative.  

 

30.1 Applicants, Representatives 

1 In the Euro-PCT(1200E) Names section, double-click a function to 
open the corresponding Details window. 

 

Figure 197: Euro-PCT(1200E) Names, Applicant 
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30.1.1 Applicant 
1 In the Applicant window select the check box Changes which have 

not yet been recorded by the International Bureau. 

2 Type the changes. 

 

Figure 198: Euro-PCT(1200E) Applicant details 

 

30.1.1 Address for correspondence 
When you select Applicant, the option for Correspondence Address is 
displayed. 

Procedural note It is essential to enter the Registration number. This 
number identifies the applicant or representative to the EPO and is an 
important reference for communications and for processing the Euro-
PCT(1200) form. 

 

1 Enter the correspondence address details. 

To save retyping an existing address, you can click the Address Book 
button. 

Note Only entries for legal persons in the Address Book are offered here. 
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Figure 199: Euro-PCT(1200E) Address for correspondence 

 

30.1.1 Representative 
1 In the Representative window select the appropriate type of entry for 

the representative: 

§ Association 
§ Authorised representative 
§ Legal practitioner 

1 Complete the details and select any options that are relevant to the 
current Euro-PCT(1200) form. 
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Figure 200: Euro-PCT(1200E) Representative details 

 

 
 



 

100 epoline® Online Filing User guide 
 

31 Euro-PCT(1200E) States 

The States section of Euro-PCT(1200E) is where you designate the 
countries in which you require patent protection. You may also select 
extension states. 

Procedural note The list of states is valid as of the last maintenance 
data update. Live Update provides a service for updating the Online 
Filing software itself, plus the maintenance and fees data. The Live 
Update option is located in File Manager Tools, Settings. 

31.1 Designation 

1 In the Euro-PCT(1200E) States section, double-click Designation. 

 

Figure 201: Euro-PCT(1200E) States, Designation 

 

The Designation Fees window opens. 

2 Select the option for seven times the amount of the designation 
fee 

Or  
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Select the option for fewer than seven designation fees. 

 

Figure 202: Euro-PCT(1200E) States, Designation Fees 

 

To consult the most up-to-date version of the EPC go to the EPC 
website (http://www.european-patent-office.org/legal/epc/). 

31.1 Extension fees 
 

1 In the Euro-PCT(1200E) States section, double-click Extension. 
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Figure 203: Euro-PCT(1200E) Names, Extension fees 

 

2 In the Extension Fees window select the option all states with 
extension agreements. 

Or 

Select the option the states ticked below, and then select the check 
boxes to specify the ones you require. 

 

Figure 204: Euro-PCT(1200E) States, Extension fees 
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32 Euro-PCT(1200E) Biological Material 

The Biological Material section of Euro-PCT(1200E) is where you input 
details of biological material filed if relevant and name the depositary 
institution. 

Biological Material contains two sections for entering data: 

1 Deposit of Biological Material. 

2 Nucleotide and amino acid sequences. 

32.1 Deposit of Biological Material 

1 In the Euro-PCT(1200E) Biological Material section, double-click 
Open to add new item. 

 

Figure 205: Euro-PCT(1200E) Deposit of Biological Material 

 

To consult the most up-to-date version of the EPC go to the EPC 
website (http://www.european-patent-office.org/legal/epc/). 

 

The Biological Material window opens. 
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1 Select the options that apply to this Euro-PCT(1200) form. 

 

Figure 206: Euro-PCT(1200E) Biological Material, copy of receipt 

 

32.1 Waiver 

There is a waiver check box in the lower part of the Biological Material 
window. If this check box is selected, the file Waiver (R.28(3)) is 
automatically attached to the Euro-PCT(1200) form that is about to be 
submitted. This file is listed in the Contents section of Euro-PCT(1200E), 
on the Other Documents tab, as well as in the Documents window. 

 

32.1 Nucleotide and amino acid sequences 

1 For nucleotide and amino acid sequences, select the check boxes 
that are appropriate to this Euro-PCT(1200) form. 
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Figure 207: Euro-PCT(1200E) Nucleotide and amino acid sequences 

 

32.1 Attaching a receipt for biological material 

Once you complete the details for the deposit of biological materials, the 
Contents section, Other Documents tab of Euro-PCT(1200E) displays a 
new document type:  

Receipt(s) of deposit (biological material) 

To attach the electronic copy of the receipt: 

1 In the Euro-PCT(1200E) Contents section, click the Other 
Documents tab. 

2 Double-click the item Receipt(s) of deposit (biological material). 

The Documents window opens. 
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3 In the list on the left select Receipt(s) of deposit (biological 
material) if it is not already selected. 

4 For the electronic file, click the Browse button. 

 

Figure 208: Attaching receipt(s) of deposit (biological material) 
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5 Select your receipt file and click Open. 
The receipt must have already been prepared in Portable Document 
Format.  

6 At the warning prompt click OK to save a copy of the receipt. 

 

32.1 Removing receipts 

1 In the Euro-PCT(1200E) Contents section, Documents window, with 
Receipt(s) of deposit selected on the left, click Reset. 

The attached copy is removed. The original file remains unchanged. 

 

Figure 209: Removing receipt of deposit 
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33 Euro-PCT(1200E) Documents 

The Documents section of Euro-PCT(1200E) is where you confirm that 
the documents you are submitting here are the same as those submitted 
to the International Bureau. If there is any change, select the appropriate 
options on the form. 

33.1 Documents intended for proceedings 
before the EPO 

1 In the Euro-PCT(1200E) Documents section, select the check boxes 
appropriate to this submission. 

2 If you select unless replaced by the amendments attached, you 
must attach the appropriate documents in the Contents section. For 
more information see Euro-PCT(1200E) Contents (p 110). 

 

Figure 210: Euro-PCT(1200E) Documents 
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34 Euro-PCT(1200E) Translations 

The Translations section of Euro-PCT(1200E) is where you list the 
translations supplied in one of the official languages of the European 
Patent Office: 

§ English 
§ French 
§ German 

Translations has one section for entering data: 

§ Translations 

 

1 In the Euro-PCT(1200E) Translations section, select any check 
boxes that are appropriate to the current Euro-PCT(1200) form. 

2 Once you select a check box, attach the appropriate documents in 
the Contents section, Other Documents tab. For more information 
see Euro-PCT(1200E) Contents (p 110). 

 

Figure 211: Translations 

 

To consult the most up-to-date version of the EPC go to the EPC 
website (http://www.european-patent-office.org/legal/epc/). 
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35 Euro-PCT(1200E) Contents 

The Contents section of Euro-PCT(1200E) is where you attach 
documents to accompany the submission. Attached documents are 
copies of the original. If the original changes and you wish to include the 
changes in the Euro-PCT(1200) form, you will need to reattach it. 

The Contents section of Euro-PCT(1200E) has three tabs: 

§ Forms 
Forms attached automatically. 
§ Technical Documents 
Technical documents supplied with the previous application, or amended 
documents. 
§ Other Documents 
Additional information attached to the Euro-PCT(1200) form. 

 

35.1 Document preparation 

Note The EPO can only accept documents prepared with the correct 
settings. The key points to remember are: 

§ Correct fonts must be chosen in order to display information correctly, 
including characters such as mathematical formulae and Greek 
characters. 

§ Paper size must be A4. 
§ Page orientation must be Portrait. 

Portable Document Format hints and tips (p 275) 

 
 



 

     Euro-PCT(1200E) Contents 111 
 
 

35.2 Euro-PCT(1200E) Contents, Forms tab 

1 In the Euro-PCT(1200E) Contents section, Forms tab, double-click 
any document listed to display the complete list of attached items. 

 

Figure 212: Euro-PCT(1200E) Contents, Forms tab 

 

The Documents window opens. 

2 Double-click a document on the left to display its Status. 

 

Figure 213: Euro-PCT(1200E) Contents, Document status 
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The checklist of attached forms includes: 

Form  Description 

Request The current Euro-PCT(1200E) form for entry 
into the regional phase. 
The system prepares this in Portable Document 
Format and names it EPF1200.PDF.  

Fee settlement Reserved for future development. 

Validation log A summary of validation remarks and 
messages. 
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35.3 Euro-PCT(1200E) Contents, Technical 
Documents tab 

The technical documents, for example the description, claims and 
abstract, are as supplied with the previous application. You cannot add 
new technical documents here.  

 

Figure 214: Euro-PCT(1200E) Contents 

 

Amendments and translations can be added to Euro-PCT(1200E) only if 
the appropriate selections are made in the Documents or Translations 
sections. For more information see Euro-PCT(1200E) Documents (p 
108) and Euro-PCT(1200E) Translations (p 109). 

Once selections are made in the Documents or Translations sections, the 
attachment options are displayed. The options displayed are PatXML or 
PDF format. Please note that PatXML is planned for a future release and 
is currently unavailable for use with Euro-PCT(1200E). 

§ PatXML 
A PatXML document is a combined file called application body. It 
contains the description, claims, abstract and drawings. The starting and 
ending pages for each section are calculated automatically. 
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§ PDF  
PDF documents can be attached as separate files or as a combined file. 

 

Figure 215: Contents section, opening view 

 

Note If you select a different option after attaching documents, the 
documents are automatically removed from the current form. The original 
documents are not changed.  
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35.3.1 Euro-PCT(1200E) Attaching amended combined file 
1 In the Euro-PCT(1200E) Contents section, select the option 

Combined file for abstract, claims, description. 

2 Double-click Specification to open the Documents window. 

 

Figure 216: Opening specification 

 

3 With Specification selected on the left, click the Browse button and 
attach the file. 

 

Figure 217: Attaching amended specification 
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4 Enter the Number of claims. 

5 Enter the starting and ending page numbers for each section. 

Sections must not overlap, and all pages must be accounted for. 

The total number of pages is calculated automatically. 

 

Figure 218: Amended specification page numbers 

 

Note In the Contents section, click the Validation button to see any 
explanatory messages.  

 

In the example below, the validation message indicates that a mistake 
was made when entering the page numbers for the combined file 
specification. Overlapping page numbers are not allowed in the combined 
specification sections and all pages must be accounted for. 

 

Figure 219: Contents, Validation Messages 
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35.3.2 Euro-PCT(1200E) Attaching amended separate PDF files 
1 In the EP(1200E) Contents section, select the option PDF 

attachments. 

 

Figure 220: Selecting option for separate amended files 

 

2 Double-click a document type to open the Documents window. 

3 In the Documents window click the Browse button and attach the 
file. 
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35.3.3 Euro-PCT(1200E) Attaching amended description 
1 In the Euro-PCT(1200E) Contents section, Technical Documents 

tab, select the option PDF attachments. 

2 Double-click Description to open the Documents window. 

 

Figure 221: Description 
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3 With Description selected on the left, click the Browse button and 
attach the file. 

 

Figure 222: Attaching amended description 

 

The file is renamed to DESC.PDF. This name is for internal processing 
only, and the original file is not modified at all. 

 

Figure 223: Description file renamed 
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35.3.4 Euro-PCT(1200E) Attaching amended claims 
1 In the Euro-PCT(1200E) Contents section, Technical Documents 

tab, select the option PDF attachments. 

2 Double-click Claims to open the Documents window. 

3 With Claims selected on the left, enter the number of claims. 

4 Click the Browse button and attach the file. 

 

Figure 224: Attaching amended claims 

 

The file is renamed to CLMS.PDF. This name is for internal processing 
only, and the original file is not modified at all. 

 

Figure 225: Claims file renamed 
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35.3.5 Euro-PCT(1200E) Attaching amended drawings 
1 In the Euro-PCT(1200E) Contents section, Technical Documents 

tab, select the option PDF attachments. 

2 Double-click Drawings to open the Documents window. 

3 With Drawings selected on the left, enter the number of figures. 

4 Click the Browse button and attach the file. 

 

Figure 226: Attaching amended drawings 

 

The file is renamed to DRAW.PDF. This name is for internal processing 
only, and the original file is not modified at all. 

 

Figure 227: Drawing file renamed 
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35.3.6 Euro-PCT(1200E) Attaching amended abstract 
1 In the Euro-PCT(1200E) Contents section, Technical Documents 

tab, select the option PDF attachments. 

2 Double-click Abstract to open the Documents window. 

3 With Abstract selected on the left, click the Browse button and attach 
the file. 

 

Figure 228: Attaching amended abstract 

 

The file is renamed to ABST.PDF. This name is for internal processing 
only, and the original file is not modified at all. 

 

Figure 229: Abstract file renamed 
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35.4 Euro-PCT(1200E) Contents, Other 
Documents tab 

Documents can be attached to Euro-PCT(1200E) by selecting from the 
menu in the Other Documents tab. 

Note With Online Filing version 2.10SP2 you may now attach digitally 
certified US priority documents. In the list of document types select 
OTHER and the option US priority document in electronic format, and 
then follow the instructions. 

However, it is recommended that this feature is not used with Acrobat 
Reader version 4 as the document can neither be viewed in Online Filing 
nor opened with the Acrobat reader. Later versions of the Acrobat Reader 
may be used. 

If the waiver option was selected in the Biological material section, two 
document headings are added automatically and displayed on the Other 
Documents tab: 

§ Receipt(s) of deposit (biological material) 
§ Waiver (R.28(3)) 

 

1 In the Euro-PCT(1200E) Contents section, Other Documents tab, 
select a type of document and click Add. 

 

Figure 230: Euro-PCT(1200E) Contents, Other Documents tab 

 

The document item is added to the Checklist of submitted documents 
and files. 
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2 Double-click the document item to open the Documents window. 

 

Figure 231: Euro-PCT(1200E) Opening general authorisation 

 

3 In the Documents window, type any Details you require. 

4 Click the Browse button and attach the document. 

 

Figure 232: Euro-PCT(1200E) Attaching general authorisation 
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35.4.1 Adding document type OTHER 
1 In the Euro-PCT(1200E) Contents section, Other Documents tab, 

select the document type OTHER and click Add. 

 

Figure 233: Euro-PCT(1200E) Selecting document type OTHER 

 

The word <specify> appears. 

 

Figure 234: Document type OTHER, specify 

 

2 Type a name for the document and click Add. 

 

Figure 235: Document type OTHER, sample data 
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3 Double-click the document item to open the Documents window. 

 

Figure 236: Opening document item, sample data 

 

4 In the Documents window, type any Details you require. 

5 Click the Browse button and attach the document. 

 

Figure 237: Attaching document type OTHER, sample data 

 

 
 



 

     Euro-PCT(1200E) Payment 127 
 
 

36 Euro-PCT(1200E) Payment 

The Payment section of Euro-PCT(1200E) is where you specify the 
mode of payment and give details of account number and account name.  

Payment contains two sections for entering data: 

1 Payment 

2 Information needed for calculation of fees 

36.1 Payment 

1 In the Euro-PCT(1200E) Payment section, select an option from the 
Mode of payment list. 

2 Enter the additional information appropriate to the mode of 
payment selected. 

3 If appropriate select the check box Reimbursements (if any) should 
be made to the following EPO deposit account and complete the 
details. 

4 If appropriate select the check box to request any additional sets of 
copies of documents and enter the number of copies required. 

 

Figure 238: Euro-PCT(1200E) Payment 
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36.2 Information needed for calculation of 
fees 

1 Select the check boxes appropriate to the Euro-PCT(1200) form.  

If you select International Preliminary Examining Authority = EP, the 
preliminary examination report options become available; select the 
appropriate option.  

If you select Number of claims on entry into the regional phase, type 
the number of claims in the box to the right.   

This number is carried forward to the Fees section, minus 10. For 
example, if you type 15, the number 5 appears in the Fees section. 

 

Figure 239: Euro-PCT(1200E) Payment information 
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37 Euro-PCT(1200E) Fees 

The Fees section of Euro-PCT(1200E) is where fees associated with the 
submission are calculated. 

The Fees section has three tabs: 

§ Standard Fees 
Fees normally associated with a Euro-PCT(1200E) form, for example, 
Search, Claims and Renewal fee for the 3rd year. 
§ Other Fees 
Priority document and subsequent renewal fees. 
§ Additional Fees 
Fees applying to a variety of circumstances (targeted for future 
development) 

The fees displayed depend on the option you chose in the Payment 
section. Click the drop-down arrow to get the Fee schedule valid as of: 
date. The fee information is held in the Maintenance section. You can 
only view it here. Live Update provides a service for updating the Online 
Filing software itself, plus the maintenance and fees data. The Live 
Update option is located in File Manager Tools, Settings. 

 
 

37.1 Euro-PCT(1200E) Fees, Standard Fees 
tab 

Please ensure that you are using the current fees. Live Update provides 
a service for updating the Online Filing software itself, plus the 
maintenance and fees data. The Live Update option is located in File 
Manager Tools, Settings. 

 

1 In the Euro-PCT(1200E) Fees section, click the Standard Fees tab. 

2 Select the date from the Fee schedule for EUR valid as of: list. 

The standard fees and their descriptions are listed, with the relevant 
options selected.  
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The total amount due is displayed in the lower part of the form. 

 

Figure 240: Euro-PCT(1200E) Fees, Standard Fees tab 

 
 

37.2 Euro-PCT(1200E) Fees, Other Fees tab 

1 In the Euro-PCT(1200E) Fees section, click the Other Fees tab. 

2 Select the date from the Fee schedule for EUR valid as of: list. 

3 Select the check boxes for the fees you wish to see. 

The amounts are imported from the Fee schedule. 
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The total amount due is displayed in the lower part of the form. 

 

Figure 241: Euro-PCT(1200E) Fees, Other Fees tab 

 
 

37.3 Euro-PCT(1200E) Fees, Additional Fees 
tab 

1 Click the Additional Fees tab. 

2 Select the date from the Fee schedule for EUR valid as of: list. 

3 Select the check boxes for the fees you wish to see. 

The fees are displayed. 
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The total amount due is displayed in the lower part of the form. 

 

Figure 242: Euro-PCT(1200E) Fees, Additional Fees tab 

 

Note The Additional Fees option is targeted for future development. 
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38 Euro-PCT(1200E) Annotate 

The Annotate section is where you can see all the notes that have been 
made for this request. You can also add notes here. A note (for EPO) is 
a comment intended for those receiving the application as part of the data 
submitted. A note (internal) is for internal use only and is not transmitted 
to the EPO. 

38.1 Adding notes 

1 In the Euro-PCT(1200E) Annotate section, select a type of note and 
click Add. 

 

Figure 243: Adding a note 

 

The Note window opens. 
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2 Type the information you require. 

 

Figure 244: Annotate, completing note details 

 

You can also add notes from the shortcut menus of other sections. 
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38.1.1 Deleting notes 
1 In the Annotate section, click a note to select it. 

2 Right-click the note to display the shortcut menu. 

3 In the shortcut menu select Cut. 

Note This operation cannot be undone. 

 

38.1 Validation log 

The Annotate section contains the Validation log of all the validation 
messages for this request. You can access the individual messages from 
the menu for each section. 

1 To display individual validation messages related to completing the 
form correctly, click the Validation button in the sections. 

 

Figure 245: Validation button 
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2 In the Euro-PCT(1200E) Annotate section, double click Validation 
log to see the entire list. 

 

Figure 246: Validation log 

 

The validation log opens. 

3 Scroll through the list to see all the messages. 

 

Figure 247: Euro-PCT(1200E) Validation log, sample data 
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Note In addition to checking individual sections, the system also carries 
out global validation, that is, it cross-checks the overall correctness of 
the submission. For example, if in the Documents section you select the 
option unless replaced by the amendments attached, in the Contents 
section the traffic light remains amber until you attach the amended 
document(s).  
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39 PCT-RO-101 Overview 

PCT-RO-101 allows you to submit Patent Cooperation Treaty (PCT) 
applications electronically. It is used for requesting entry into the regional 
phase before the EPO as designated or elected office. 

PCT-RO-101 is organised into several parts to help you process your 
form: menu, toolbar and sections. When you click a section to select it, 
the options for that section are displayed. These represent the types of 
information you need to complete for this request.  

As you prepare the application, two features will help you decide whether 
the information is complete and correct: 

For more information see Traffic lights (p 235) and Validation 
messages (p 235). 

 
 

39.1 Creating new PCT-RO-101 forms 

1 In File Manager select New Form, PCT Form from the File menu. 

 

Figure 248: Creating a new form, PCT form 

 

You can also create a new form in File Manager by double-clicking the 
Normal template, PCT-RO-101.  

The New application window opens. 

2 Select an option from the Language of the proceedings list. 

3 Enter a user reference.  

This reference must be unique. It is the name of this patent application. 

4 Select the option to use File Manager categories if you wish.  

Categories allow you to group forms in a way that is meaningful to your 
organisation, for example by type of content or department. Forms can 
then be sorted and displayed by category. 
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39.2 PCT-RO-101 Sections 

The PCT-RO-101 sections organise the information needed to complete 
a PCT patent application.  

 

Section Description 

Request 
The Request section of PCT-RO-101 is 
where you request the grant of a PCT patent, 
give the application a title and set the 
language. 

States 
The States section of PCT-RO-101is where 
you designate the contracting states for the 
application. 

Names 
The Names section of PCT-RO-101is where 
you enter applicant, agent and inventor 
details. 

Priority 
The Priority section of PCT-RO-101 is 
where you claim national, regional or 
international priority. 

Biology 
The Biology section of PCT-RO-101 is 
where you input details of biological material 
filed if relevant and name the depositary 
institution. 

Declarations 
The Declarations section of PCT-RO-101 is 
where you make applicant or inventor 
declarations. 

Contents 
The Contents section of PCT-RO-101 is 
where you attach the description, claims and 
other documents. 

Fees The Fees section of PCT-RO-101 is where 
you calculate fees. 

Payment The Payment section of PCT-RO-101 is 
where you set payment choices. 

Annotate The Annotate section of PCT-RO-101 is 
where you add remarks to the application. 
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39.3 PCT-RO-101 Menu options 

The PCT-RO-101 menu lists common tasks. The options available 
depend on the circumstances. 

 

Menu  Description 

File Sign  Add electronic signatures. 

 Save as Ready 
for Signing 

Move to the Ready to Sign folder. 

 Save as Draft Save work so far for later 
completion. 

 Save as 
Template… 

Save work as a basis for creating 
new forms. 

 Export unpacked 
WAD to... 

Saves all data into XML files which, 
together with all attached document 
files, are stored in a selected 
directory. 

 Export WAD to... Saves all data into XML files which, 
together with all attached document 
files, are stored in a compressed 
ZIP file. 

 Preview Display the form in PDF format. 

 Print Print the application in PDF format. 

 Close Form Shut current patent application. 

Edit Undo Ctrl+Z Reverse last action or clear the 
screen. 

 Cut Ctrl+X Remove selected item. 

 Copy Ctrl+C Make a duplicate of selected item. 

 Paste Ctrl+V Insert duplicated item. 

 Delete Ctrl+D In the Names section, delete 
selected entry. This option is only 
available if information has been 
entered. 

 Remark Add a comment intended for those 
receiving the application, as part of 
the data submitted. 
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Menu  Description 

 Private Remark Add a comment for internal use 
only, not transmitted to the EPO. 

View Request Display the Request section. 

 States Display the States section. 

 Names Display the Names section. 

 Priority Display the Priority section. 

 Biology Display the Biology section. 

 Declarations Display the Declarations section. 

 Contents Display the Contents section. 

 Fees Display the Fees section. 

 Payment Display the Payment section. 

 Annotate Display the Annotate section. 

Tools Validation See Validation messages and 
remarks. 

Help Contents  

About PCT 
Online Filing 

Accesses the Help file. 

Displays PCT Online Filing general 
information and WIPO Helpdesk 
details. 
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39.4 PCT-RO-101 Toolbar options 

PCT-RO-101 toolbar buttons provide quick access to common tasks.  

 

Button Description 

 
Previews the page. 

 
Prints the page. 

 
Signs the form. 

 
Saves the form as ready sign. 

 
Opens the Help window. 

 
Displays validation messages. 

 

Move the mouse pointer over a button to see a brief description of what it 
does. If a function is not currently available the button will be dimmed. 
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40 PCT-RO-101 Request 

The Request section of PCT-RO-101 is the first one selected in a new 
PCT application.  

40.1 Entering request details 

1 In the PCT-RO-101 Request section, select an option from the 
Receiving Office list. 

2 Select the International Searching Authority (ISA). 

3 Select the Language of filing of the international application. 

4 Enter the Title of invention. 

The title should be short, concise and entered in CAPITAL letters. 

 

Figure 249: PCT-RO-101 Request 
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40.2 Request to use results of earlier search 

1 Select the option Request to use results of earlier search if 
appropriate.  

2 Double-click Open to add reference to earlier search to supply the 
additional information. 

 

Figure 250: PCT-RO-101 Request, Results of earlier search 

 

The Details of Earlier Search window opens. 

3 Select an option from the Country (or regional Office) list. 

This is the office of filing of the application or request for earlier search. 
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4 Enter the date. 
This is the date on which the application or request for earlier search 
was filed. 

5 Enter the reference number. 
This is the number of the application or request for earlier search. 

 

Figure 251: Details of earlier search 

 

40.1 Deleting results of earlier search 

The results of earlier search are numbered and listed in the Request 
section.  

1 To delete an item from the list, right-click it and select Cut from the 
shortcut menu. 

 

Figure 252: Deleting details of earlier search 
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41 PCT-RO-101 States 

41.1 Designations 

All Contracting States bound by the PCT on the international filing date 
are designated with the filing of this request. However, you may select 
the option NOT to designate Germany, the Republic of Korea or the 
Russian Federation for any kind of national protection. Use the check 
boxes provided to exclude irrevocably the designations concerned. 

 

Figure 253: PCT-RO-101 Designations 
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Note The WIPO website provides the current list of PCT Contracting 
States. To view the list, click the link provided. 

41.1 Reference to parent application or grant 

1 To display the options, click Reference to parent application or 
grant. 

The OAPI and National options are displayed. 

 

Figure 254: Options for reference to parent application 

 

Note Once a reference is made, the Reference to parent application or 
grant check box is automatically selected. The validation colour for the 
States section will display as green only if the reference information have 
been entered correctly. Click the Validation button to see any messages. 
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41.2 PCT-RO-101 OAPI patent 

1 In the PCT-RO-101 States section, click Reference to parent 
application or grant. 

2 Click OAPI parent application or grant. 

3 Select an option from the Kind of parent application or grant list.  

4 Enter the parent application or grant number. 

5 Enter the parent application or grant date in the format displayed. 
Do not type the full stops. 

-OR- 

Click the Calendar button and select a date. 

 

 

Figure 255: PCT-RO-101 States, changing OAPI patent details 
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41.3 PCT-RO-101 National patent 

1 In the PCT-RO-101 States section, click Reference to parent 
application or grant. 

2 Click National parent application or grant. 

3 Select the State you require 

4 Double-click the characters “…” in blue to view the available options. 

 

Figure 256: PCT-RO-101 National patent designations 

 

5 Select an option from the Kind of parent application or grant list.  

6 Enter the parent application or grant number. 

7 Enter the parent application or grant date in the format displayed. 
Do not type the full stops. 

-OR- 
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Click the Calendar button and select a date. 

 

 

Figure 257: Options available for parent application or grant 
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42 PCT-RO-101 Names 

The Names section of PCT-RO-101 is where contact details are supplied 
for the persons involved in this application.  

 

Figure 258: PCT-RO-101 Names, List of functions 

42.1 Completing names and details 

Details can be added for the following functions: 

§ Applicant 
§ Inventor 
§ Agent 
§ Common Representative. 
§ Correspondence Address 

 

1 In the PCT-RO-101 Names section, select a function and click Open. 

You can also double-click the function name: applicant, inventor, agent, 
common representative and correspondence address. 

The corresponding window opens.  
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42.1 Declarations concerning applicant or 
inventor 

You may add declarations concerning the applicant, inventor or invention: 

§ Declaration as to the identity of the inventor. 
§ Declaration as to the applicant’s entitlement to apply for and be 

granted a patent. 
§ Declaration as to the applicant’s entitlement to claim priority of an 

earlier application. 
§ Declaration of inventorship. 
§ Declaration as to non-prejudicial disclosures or exceptions to lack of 

novelty. 

For more information see PCT-RO-101 Declarations (p 179). 

 
 

42.2 PCT-RO-101 Details concerning 
applicant 

1 In the PCT-RO-101 Names section, double-click the Applicant 
function to open the Details concerning Applicant or 
Applicant/inventor window.  

 

Figure 259: PCT-RO-101 Names, Applicant 

 

2 Select the option for either legal entity or natural person. 

If legal entity is selected, the first name option is unavailable. 

For a natural person, select the check box This person is also inventor 
if appropriate. 

Enter the name (ie surname) in CAPITAL letters and the first name with 
the first letter only capitalised. 

Titles and academic degrees must be omitted. 
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3 Enter the registration number. Please note that this is essential as 
the registration number facilitates proper allocation to our back end 
system. 

4 Enter the country code and address details. 

5 Enter the telephone and facsimile numbers including the 
applicable country and area codes. 

6 Select an option for the states for which this person is applicant. 

7 To add additional applicant names click the +Applicant option, and 
then click Open.  

As applicants are added, the system numbers them in order.  

 

Figure 260: PCT-RO-101 Details concerning Applicant 

 

42.2.1 Designating certain states only for applicant 
When the Certain designated States only option is selected, the 
select/modify button becomes available. 

1 Click select/modify. 
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Figure 261: PCT-RO-101 Names, certain states only 

 

The View/Change Omissions window opens. 
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2 Select the check boxes to indicate the individual states for which this 
person is the applicant, or click Select All as appropriate. 

 

Figure 262: PCT-RO-101 View/Change Omissions 
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42.2.2 PCT-RO-101 Common representative 
If more than one applicant is entered, the Common Representative 
option becomes available if no agent or correspondence address is used. 
Agent, common representative and correspondence address are mutually 
exclusive options, resulting in the automatic disappearance of the other 
two.  

1 In the PCT-RO-101 Names section, double-click the Common Rep. 
function. 

   
 

The Details concerning Common Representative window opens. 
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2 Select the appropriate applicant from the Name list. 

The applicant details are completed automatically. 

 

Figure 263: PCT-RO-101 Details concerning Common Representative 
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42.2.3 PCT-RO-101 Special correspondence address 
Once the applicant details are entered, the Correspondence Address 
function appears in the Names section. Use this to indicate a special 
address to which correspondence should be sent. The function agent will 
then disappear. 

1 In the PCT-RO-101 Names section, double-click the item +Corr. 
Address. 

 

Figure 264: PCT-RO-101 Names, Correspondence Address 

 

The Details concerning Special Address for Correspondence window 
opens. 

2 Enter the details you require. 

 

Figure 265: PCT-RO-101 Names, Special Address for Correspondence 
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42.3 PCT-RO-101 Details concerning inventor 

1 In the PCT-RO-101 Names section, double-click the Inventor only 
function to open the Details concerning Inventor Only window.  

 

Figure 266: PCT-RO-101 Names, Inventor only 

 

2 Enter the name (ie surname) in CAPITAL letters and the first name 
with the first letter only capitalised. 

Titles and academic degrees must be omitted. 

3 Enter the country code and address details. 

4 To add additional inventor names click the +Inventor option, and 
then click Open.  

As inventors are added, the system numbers them in the order entered.  

 

Figure 267: PCT-RO-101 Details concerning Inventor Only 

 
 



 

 PCT-RO-101 Names 161 
 
 

42.3.1 PCT-RO-101 Deceased inventor 
For the purposes of the designation of the United States of America, the 
successor to the rights of the deceased inventor can be selected. This 
option becomes available when: 

§ In the Names section, an applicant is designated for the US. 
§ In the Names section, the Deceased option is selected for the 

inventor. 

The applicant names that appear on the list are those whose 
designations include the United States of America. 

1 In the Names section, select the check box for the applicant(s) who is 
(are) successor(s) to the rights of the deceased inventor. 

2 After selecting an applicant, double-click in the corresponding 
Capacity box. 

 

Figure 268: PCT-RO-101 Inventor Only, selecting applicant 

 

The Capacity list appears. 
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3 Select the appropriate option from the Capacity list. 

4 Repeat these steps where there is more than one legal 
representative for the deceased inventor. 

 

Figure 269: PCT-RO-101 Selecting executor for deceased inventor 

 
 

42.4 PCT-RO-101 Details concerning agent 

1 In the PCT-RO-101 Names section, double-click the Agent function 
in the Names section to open the Details concerning Agent 
window.  

2 Select the option either for Legal entity or Natural person. 

If legal entity is selected, the First Name option is unavailable. 

Enter the name (ie surname in the case of a natural person) in CAPITAL 
letters and the first name with the first letter only capitalised. 

Titles and academic degrees must be omitted. 
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3 Enter the registration number. Please note that this is essential as 
the registration number facilitates proper allocation to our back end 
system. 

4 Enter the country code and address details. 

5 Enter the telephone and facsimile numbers including the applicable 
country and area codes. 

6 Click OK to return to the PCT-RO-101 Electronic Request. 

7 To add additional agent names click the +Agent option, and then 
click Open.  

As agents are added, the system numbers them in the order entered.  

 

Figure 270: PCT-RO-101 Details concerning Agent 
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42.5 PCT-RO-101 Adding names from 
Address Book 

You can enter names in your Address Book and then use them in patent 
application forms. To add a name to a patent application from the 
Address Book: 

1 In the PCT-RO-101 Names section select a function from the list.  

2 Click Address Book. 

 

Figure 271: PCT-RO-101 Adding name from Address Book 

 

The Address Book Exchange window opens. 

The existing Address Book names are displayed in the upper half of the 
screen.  
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3 Click a name to select it, and then click a function button in the 
middle of the screen, for example Applicant only. 

The entry is added to the Names section of the current form. 

 

Figure 272: PCT-RO-101 Address Book Exchange 

 

Note To remove a name you have added from the Address Book, select 
it and then click Remove. 
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42.6 PCT-RO-101 Adding names to Address 
Book 

You can save applicant, inventor and agent details in the Address Book 
for reuse. 

1 In the PCT-RO-101 Names section click Address Book. 

 

Figure 273: PCT-RO-101 Adding names to Address Book 

 

The Address Book Exchange window opens. The names you have 
created are listed in the lower half of the screen. 
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2 Select the name you wish to save. 

3 Click Copy to Address Book.  

 

Figure 274: Address Book Exchange, Copy to Address Book 
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42.7 PCT-RO-101 Creating a power of attorney 
document 

You can create a power of attorney document in PDF format and attach 
it to the application. The Power of Attorney option becomes available in 
these situations: 

§ At least one applicant and one agent are added. 

-OR- 

§ More than one applicant and a common representative are added. 

 

1 In the PCT-RO-101 Names section, click Power of Attorney. 

 

Figure 275: PCT-RO-101 Names, Power of Attorney 

 

The Power of Attorney window opens. 
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2 Select the applicant(s) giving power of attorney. 

3 Select the agent(s)/common representative to whom power of 
attorney is given. 

4 Select the applicable authority from the drop-down list in the lower 
part of the form. 

5 Select a date. 

6 Click Sign. 

 

Figure 276: PCT-RO-101 Signing power of attorney 

 

The PDF Viewer window opens. 
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7 Scroll through the information, and then click Continue. 

 

Figure 277: PCT-RO-101 PDF viewer, sample data 

 

The List of Signatories window opens. 

8 Add the appropriate signatory.  

Signing forms (p 243). 
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43 PCT-RO-101 Priority 

The Priority section of PCT-RO-101 is for specifying details of an earlier 
application for which priority is claimed. 

For each national, regional priority and international claim a matching 
item is added automatically to the Contents section, Accompanying 
Items tab. This only happens when the receiving Office has not been 
requested to prepare and transmit a copy to the International Bureau. For 
more information see PCT-RO-101 Attaching Priority Claim 
documents (See "PCT-RO-101 Attaching priority claim document" p 
223). 

Note Priority claims appear in the same order in which they are entered.  

 
 

43.1 Creating priority claims 

1 In the PCT-RO-101 Priority section, click Open to add a priority 
claim. 

 

Figure 278: PCT-RO-101 Priority, Add Priority Claim 

 

The Details of Priority Claim of Earlier Application window opens. 
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2 Select the appropriate option: National, Regional or International 
(PCT). 

3 From the Country list select the country where the earlier application 
was filed.  

4 Enter the filing date of the earlier application. 

5 Enter the application number that was assigned to the earlier 
application. 

6 Select the option to request a certified copy if appropriate. 

 

Figure 279: PCT-RO-101 Details of Priority Claim 

 

43.1 Sorting priority claims 

If additional priority claims are entered, they can be sorted 
chronologically. 

1 Right-click one of the priority claims. 

2 In the shortcut menu select sort priority claims chronologically. 
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Figure 280: PCT-RO-101 Sorting priority claims chronologically 

 

43.1.1 Deleting a priority claim 
1 Right-click the priority claim you wish to delete. 

2 Select Cut from the shortcut menu. 

Note This action cannot be undone. 
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43.2 PCT-RO-101 Regional option for ARIPO 

Where Regional and ARIPO are both selected in Details of Priority 
Claim of Earlier Application, the following option becomes available:  

Country Party to Paris Convention for Protection of Industrial 
Property or Member of the World Trade Organization for which 
earlier application was filed. 

1 In the PCT-RO-101 Priority section, Details window, enter the filing 
date. 

2 Enter the number assigned to the earlier application. 

3 Select an option from the list of states in the lower part of the window. 

4 If appropriate, select the check box for a certified copy. 

 

Figure 281: PCT-RO-101 ARIPO regional option 
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44 PCT-RO-101 Biology 

The Biology section of PCT-RO-101 is where the following information is 
provided: 

§ Details concerning biological material filed if relevant. 
§ Name of the depositary institution. 

 

44.1 Entering details concerning biological 
material 

1 In the PCT-RO-101 Biology section, click Open. 

 

Figure 282: PCT-RO-101 Deposit of biological material 

 

The Details concerning Indications Relating to a Deposited 
Microorganism window opens.  
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2 Enter the paragraph number of indications relating to the deposit of 
biological material. 

3 Select a depositary institution from the drop-down list. 

4 To the right of the acronym of the depositary Institution, enter the 
accession number attributed to the deposit. 

5 Enter the date of deposit. 

6 Type a short description of additional Indications if applicable. 

7 Type separate furnishing of indications if applicable. 

8 Select an option for Designated States. 

 

Figure 283: PCT-RO-101 Details concerning indications 
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Note You may attach separate indications concerning deposited 
microorganisms or biological material. For more information see PCT-
RO-101 Attaching separate indications for biological material (See 
"Attaching separate indications for biological material" p 219). 

 

44.1 Deleting indications of biological 
material 

1 In the Biology section right-click the item you wish to delete. 

2 Select Cut from the shortcut menu. 

Note This action cannot be undone. 

 

 
 

44.2 PCT-RO-101 Nucleotide and amino acid 
sequences 

1 In the PCT-RO-101 Biology section under the heading Nucleotide 
and/or amino acid sequence listing, select the appropriate check 
box(es):  

The description contains a sequence listing.  
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The description contains tables related thereto. 

 

Figure 284: PCT-RO-101 Deposit of biological material 

 

Selecting the first option automatically adds this document heading to the 
Contents section, International Application tab: 

§ Sequence listing. 

Selecting the second option automatically adds this document heading to 
the Contents section, International Application tab: 

§ Tables related to sequence listing. 

 

PCT-RO-101 Attaching sequence listings (See "PCT-RO-101 
Attaching sequence listings in PDF form" p 205). 

 

 
 



 

 PCT-RO-101 Declarations 179 
 
 

45 PCT-RO-101 Declarations 

The Declarations section of PCT-RO-101 is where Declaration sheets 
are provided.  

1 In the PCT-RO-101 Declarations section, select an option from the 
Declarations list, and then click Add. 

Note The Print declarations button becomes available after the 
submission process, when the form is opened from the Sent folder. 

 

Figure 285: PCT-RO-101 Declarations, Selecting declaration 

 

The corresponding Declarations window opens.  

2 Complete the information. 
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45.1 PCT-RO-101 Declaration as to identity of 
inventor 

In this example, Declaration as to the identity of the inventor is 
selected. 

1 Select the applicable Designation option in the lower part of the 
window.  

2 Double-click the Inventor heading to open the Details window. 

 

Figure 286: PCT-RO-101 Declarations, Identity of inventor 

 

The Details concerning Inventor window opens. 

3 Select an option from the Name list, or enter a name. 

The names in the list are taken from the Address Book. 
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4 Enter the other details. 

 

Figure 287: PCT-RO-101 Declarations, Details concerning inventor 
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45.2 PCT-RO-101 Declaration as to applicant 
entitlement 

The example below adds a Declaration as to the applicant’s 
entitlement to apply for and be granted a patent. 

1 Select the appropriate declaration from the option list, and then click 
Add. 

 

Figure 288: PCT-RO-101 Declarations, Applicant's entitlement 

 

The corresponding Declarations window opens. 

1 Select an option from the Applicant list, or enter an applicant name. 

The names in the list are taken from the Address Book. 

 

2 In the Status/Event column double-click Add item. 

 

Figure 289: PCT-RO-101 Declarations, Add item 

 

The Status/Event window opens. 
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3 Select the appropriate status or event. 

In the example below, court order is selected. 

 

Figure 290: PCT-RO-101 Declarations, Status/Event, court order 

 

4 Complete any additional information appropriate to the status or 
event. 

 

Figure 291: PCT-RO-101 Status/Event, court order details 
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45.3 PCT-RO-101 Declaration of inventorship 

The example below adds a Declaration of inventorship. 

1 Select the appropriate declaration from the option list, and then click 
Add. 

 

Figure 292: PCT-RO-101 Declaration of inventorship 

 

The corresponding Declarations window opens. 
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2 Double-click Add Prior Application to enter the details. 

 

Figure 293: PCT-RO-101 Adding prior application 

 

The Details of prior applications window opens. 

3 Enter the appropriate information, and then click OK. 

 

Figure 294: PCT-RO-101 Entering details of prior application 
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4 Double-click Add Applicant/Inventor to enter details. 

 

Figure 295: PCT-RO-101 Adding applicant/inventor details 

 

The Details concerning inventor window opens. 
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5 Enter the appropriate information, and then click OK. 

 

Figure 296: PCT-RO-101 Entering inventor details 
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6 In the Declarations window click Sign. 

 

Figure 297: PCT-RO-101 Signing declaration of inventorship 

 

The List of Signatories window opens. 

7 Add the appropriate signatory.  

For more information see Signing forms (p 243). 
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45.4 PCT-RO-101 Declaration as to non-
prejudicial disclosures 

The example below adds a Declaration as to non-prejudicial 
disclosures or exceptions to lack of novelty. 

1 Select the appropriate declaration from the option list, and then click 
Add. 

 

Figure 298: PCT-RO-101 Declaration as to non-prejudicial disclosures 

 

The corresponding Declarations window opens. 
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2 Double-click Add Disclosure to enter the details. 

 

Figure 299: PCT-RO-101 Adding disclosure 

 

The Disclosure window opens. 

3 Enter the disclosure details, and then click OK. 

 

Figure 300: PCT-RO-101 Entering disclosure details 
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45.5 PCT-RO-101 Deleting declarations 

1 In the Declarations section, right-click the declaration you wish to 
delete. 

2 In the shortcut menu click Cut. 

Note This action cannot be undone. 
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46 PCT-RO-101 Contents 

The Contents section of PCT-RO-101 is where documents are attached 
to support the patent application. Attached documents are copies of the 
original. If the original changes and you wish to include the changes in 
the patent application, you will need to reattach it.  

The Contents section of the PCT-RO-101 Electronic Request has two 
tabs: 

§ International Application 
Mandatory and recommended documents for the current patent 
application.  

§ Accompanying Items 
Additional information you may wish to include. 

A red traffic light indicates that a mandatory document has not yet been 
attached.   

Click the Validation button in the menu bar to see any explanatory 
messages. 

 

Figure 301: Validation button 

 

46.1 Document preparation 

Note The EPO can only accept documents prepared with the correct 
settings. The key points to remember are: 

§ Correct fonts must be chosen in order to display information correctly, 
including characters such as mathematical formulae and Greek 
characters. 

§ Paper size must be A4. 
§ Page orientation must be Portrait. 

Portable Document Format hints and tips (p 275) 
 



 

 PCT-RO-101 Contents 193 
 
 

46.2 PCT-RO-101 International Application tab 

The PCT-RO-101 Contents section, International Application tab is where 
the documents supporting the patent application are attached. These 
documents can be prepared in XML or PDF format. 

§ XML 
An XML document is a combined file called Application body. It contains 
the description, claims, abstract and drawings.  

§ PDF  
PDF documents can be attached as separate files or as a single 
specification file. 
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Note If you select a different option after attaching documents, the 
documents are automatically removed from the current form. The original 
documents are not affected.  

 

Figure 302: PCT-RO-101 Contents, International Application tab 

 

46.2.1 Removing attached documents 
1 In the PCT-RO-101 Content Details window, double-click the 

appropriate item and click Reset. 

 

Figure 303: PCT-RO-101 Removing documents 
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46.2.2 XML attachments 
1 In the Contents section, select the option XML attachments. 

2 Double-click Application body. 

 

Figure 304: XML attachments 

 

The Content Details window opens. 
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3 Click the Browse button and attach the relevant document.  

4 Enter the number of pages. 

 

Figure 305: Attaching XML application body 

 

This document is attached automatically and named application-
body.xml. 
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46.2.3 PDF attachments 

46.2.4 PCT-RO-101 Attaching descriptions 
1 In the PCT-RO-101 Contents section, International Application 

tab, select the option PDF attachments. 

2 Double-click Description to open the Documents window. 

 

Figure 306: PCT-RO-101 Contents, Description 
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3 With Description selected on the left, click the Browse button. 

4 Navigate to the description document and attach it. 

 

Figure 307: PCT-RO-101 Content Details, description 
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46.2.5 PCT-RO-101 Attaching claims 
1 In the PCT-RO-101 Contents section, International Application 

tab, select the option PDF attachments. 

2 Double-click Claims to open the Content Details window. 

 

Figure 308: PCT-RO-101 Contents, attaching claims 
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3 Click the Browse button. 

4 Navigate to the claims document and attach it. 

 

Figure 309: PCT-RO-101 Content Details, claims 
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46.2.6 PCT-RO-101 Attaching abstracts 
1 In the PCT-RO-101 Contents section, International Application 

tab, select the option PDF attachments. 

2 Double-click Abstract to open the Content Details window. 

 

Figure 310: PCT-RO-101 Attaching abstract 
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3 With Abstract selected on the left, click the Browse button. 

4 Navigate to the Abstract document and attach it. 

 

Figure 311: PCT-RO-101 Content Details, Abstract 
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46.2.7 PCT-RO-101 Attaching drawings 
1 In the PCT-RO-101 Contents section, International Application 

tab, select the option PDF attachments. 

2 Double-click Drawings to open the Content Details window. 

 

Figure 312: PCT-RO-101 Contents, Drawings 
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3 With Drawings selected on the left, enter the Figure of the 
drawings which should accompany the abstract. 

4 Click the Browse button. 

5 Navigate to the drawings document and attach it. 

 

Figure 313: PCT-RO-101 Content Details, Drawings 
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46.2.8 PCT-RO-101 Attaching sequence listings in PDF form 
The heading Sequence listing appears automatically in the Contents 
section, International Application tab, when the option The description 
contains a sequence listing is selected in the Biology section, Nucleotide 
and/or amino acid sequence listing section. For more information see 
PCT-RO-101 Nucleotide and amino acid sequences (p 177). This is a 
PDF document. 

1 In the PCT-RO-101 Contents section, International Application 
tab, double-click the Sequence listing option. (If necessary scroll 
down the list to display it.) 

 

Figure 314: PCT-RO-101 Attaching sequence listing 

 

The Content Details window opens. 
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2 Click the Browse button  

3 Navigate to the sequence listing document and attach it. 

 

Figure 315: Attaching sequence listing 

 

46.2.1 Removing sequence listings 
1 In the Biology section clear the check box The description 

contains a sequence listing.  

The headings and attached documents are automatically removed from 
the Contents section.  
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46.2.2 PCT-RO-101 Attaching tables related to sequence listing 
The heading Tables related to sequence listing appears automatically 
in the Contents section, International Application tab, when the option 
The description contains tables related thereto is selected in the 
Biology section, Nucleotide and/or amino acid sequence listing. PCT-RO-
101 Nucleotide and amino acid sequences (p 177). This is a PDF 
document. 

1 In the PCT-RO-101 Contents section, International Application tab, 
double-click the Tables related to sequence listing option. (If 
necessary scroll down the list to display it.) 

 

Figure 316: PCT-RO-101 Contents, attaching tables 

 

The Content Details window opens. 
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2 Select the appropriate check box(es). 

3 Click the Browse button  

4 Navigate to the tables document and attach it. 

 

Figure 317: Attaching tables 
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46.2.3 PCT-RO-101 Attaching Single specification file 
1 In the PCT-RO-101 Contents section, International Application 

tab, select the Single specification file option. 

2 Double-click Specification to open the window. 

 

Figure 318: PCT-RO-101 Contents, Single specification file 
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3 In the Content Details window, click the Browse button and attach 
the specification file. 

The total number of pages is calculated automatically. 

 

Figure 319: PCT-RO-101 Attaching single specification 

 

4 Enter the starting and ending pages for the Description, Claims 
and Abstract. 

(If appropriate select the check box abstract is not included.) 
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Sections must not overlap, and all pages must be accounted for. 

 

Figure 320: PCT-RO-101 Single specification, Page numbers 
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46.3 PCT-RO-101 Accompanying items tab 

The PCT-RO-101 Contents section, Accompanying Items tab, contains 
a list of document types that may be attached to the current patent 
application.  

 

Figure 321: PCT-RO-101 Contents, Accompanying Items tab 

 

 
 



 

 PCT-RO-101 Contents 213 
 
 

46.3.1 PCT-RO-101 Attaching a power of attorney document 
The details relating to a power of attorney are entered in the PCT-RO-
101 Names section. These details can be printed, previewed and saved 
to a file in PDF format. For more information see Creating power of 
attorney documents (See "PCT-RO-101 Creating a power of attorney 
document" p 168). 

To attach a power of attorney file to the current application: 

1 In the PCT-RO-101 Contents section, Accompanying Items tab, 
select the appropriate power of attorney option from the drop-down 
list, and then click Add. 

 

Figure 322: PCT-RO-101 Contents, Accompanying Items tab 

 

The new heading appears in the checklist of documents. 
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2 Double-click the new item to open it. 

 

Figure 323: Opening power of attorney 

 

The Content Details window opens. 

3 Click the Browse button and attach the document. 

 

Figure 324: PCT-RO-101 Content Details, Attaching power of attorney 
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46.3.2 Attaching statement explaining lack of signature 
1 In the PCT-RO-101Contents section, Accompanying Items tab, 

select statement explaining lack of signature from the drop-down 
list, and then click Add. 

 

Figure 325: Statement explaining lack of signature 

 

The new heading appears in the checklist of documents. 

2 Double-click the new item to open it. 

 

Figure 326: Opening statement item 

 

The Content Details window opens. 
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3 Click the Browse button and attach the document. 

 

Figure 327: PCT-RO-101 Content Details, attaching statement 
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46.3.3 PCT-RO-101 Attaching translation of international 
application 

1 In the PCT-RO-101 Contents section, Accompanying Items tab, 
select translation of international application into... from the drop-
down list, and then click Add. 

 

Figure 328: Attaching translation 

 

The new heading appears in the checklist of documents. 

2 Double-click the new item to open it. 

 

Figure 329: Opening translation item 

 

The Content Details window opens. 



 

218 epoline® Online Filing User guide 
 

3 Enter a language in the translation of international application 
into: box. 

4 Click the Browse button and attach the document. 

 

Figure 330: Attaching translation document 
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46.3.4 Attaching separate indications for biological material 
The Biology section is where you enter details concerning indications 
relating to a deposited microorganism or other biological material referred 
to in the description of the invention.  

You may also attach separate indications for biological material. 

1 In the PCT-RO-101Contents section, Accompanying Items tab, 
select Separate indications concerning deposited 
microorganisms or other biological material from the drop-down 
menu, and then click Add. 

 

Figure 331: PCT-RO-101 Attaching separate indications 
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2 Double-click the new item to open it. 

 

Figure 332: PCT-RO-101 Contents, Opening separate indications 

 

The Content Details window opens. 

3 Click the Browse button and attach the document. 

 

Figure 333: PCT-RO-101 Contents, Attaching separate indications 
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46.3.5 PCT-RO-101 Attaching document type OTHER 
1 In the PCT-RO-101 Contents section, Accompanying Items tab, 

select the document type OTHER and click Add. 

 

Figure 334: PCT-RO-101 Accompanying Items, Document type OTHER 

 

The word <specify> appears. 

 

Figure 335: Document type OTHER, specify 

 

2 Type a name for the document and click Add. 

 

Figure 336: Document type OTHER, sample data 
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3 Double-click the document item to open the Content Detail window. 

 

Figure 337: PCT-RO-101 Opening document type OTHER, sample data 
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4 In the Content Details window, click the Browse button and attach 
the document. 

The number of pages is calculated automatically. 

 

Figure 338: PCT-RO-101 Attaching document type OTHER, sample data 

 

 
 

46.3.6 PCT-RO-101 Attaching priority claim document 
The Priority Claims heading appears automatically in the Contents 
section, Accompanying Items tab, when a priority claim is created in the 
Priority section. For more information see PCT-RO-101 Creating 
priority claims (See "Creating priority claims" p 171). 

1 In the PCT-RO-101Contents section, Accompanying Items tab, 
double-click the Priority Claims heading to open the Content Details 
window. 

Note The choices available depend on the receiving Office selected in 
the Priority section. If the receiving Office allows paper submission, you 
will see an option for enclosing a paper document. 
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2 Click the Browse button and attach the document. 

The Details box is completed automatically with information from the 
Priority section. 

 

Figure 339: PCT-RO-101 Content Details, attaching priority claim 
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47 PCT-RO-101 Fees 

The Fees section of PCT-RO-101 displays the fees and amounts due. 
These are calculated automatically from the data in other sections.  Fee 
amounts can also be entered or modified directly.  

1 In the PCT-RO-101 Fees section, click the drop-down arrow to get 
the Fee schedule valid from: date. 

2 To enter or modify the fee amount, double-click the number in the 
Amount column. 

3 When the background colour changes to white, enter the correct 
amount. 

4 If appropriate, select the option The designation fees are not paid 
at this time. 

 

Figure 340: PCT-RO-101 Fees 

 

The Total Fees Payable amount is calculated automatically and 
displayed in the lower part of the form.  
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Note To display the fee calculation sheet in PDF format, open the item 
in the Contents section, Accompanying items tab. In the Content 
Details window, click the Preview button.  
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48 PCT-RO-101 Payment 

The Payment section of PCT-RO-101 is where you specify the mode of 
payment and give details of the account number and account holder. Not 
all modes of payment may be available at all receiving Offices. 

To specify the payment details: 

1 In the PCT-RO-101 Payment section, select an option from the 
Mode of Payment list. 

Options are displayed for the selected mode. 

2 Enter the details for the mode of payment. 

3 Select any relevant options for the receiving Office. 

 

Figure 341: PCT-RO-101 Payment 
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If the option more than one mode of payment is selected, the itemised 
fees appear. 

1 Double-click in the blue area to the right of the fee to display the 
drop-down list. 

2 Select the appropriate Mode of Payment from the list. 

 

Figure 342: PCT-RO-101 Payment, Payment type 
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49 PCT-RO-101 Annotate 

The Annotate section is where you can see all the remarks that have 
been made for this application. A remark is a comment intended for 
those receiving the application as part of the data submitted. A private 
remark is for internal use only and is not transmitted to the EPO. 

The Annotate section also contains the Validation log with all the 
validation messages for the application. 

49.1 Adding remarks 

1 In the PCT-RO-101 Annotate section select a type of remark, and 
then click Add. 

 

Figure 343: PCT-RO-101 Annotate, Selecting type of remark 

 

The Annotation edit dialog window opens. 
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2 Type in the information you require. 

You can also add remarks from the shortcut menus of other sections. 

 

Figure 344: PCT-RO-101 Remark details 

 



 

 PCT-RO-101 Annotate 231 
 
 

49.1.1 Deleting remarks 
1 In the PCT-RO-101 Annotate section, click a remark to select it. 

2 Right-click the remark to display the shortcut menu. 

3 In the shortcut menu select Cut. 

Note This operation cannot be undone. 

 

49.1 Validation log 

The Annotate section contains the Validation log of all the validation 
messages for the application. You can access the individual messages 
from the menu for each section. 

1 To display individual validation messages related to completing the 
form correctly, click the Validation button in the sections. 

 

Figure 345: Validation button 

 

2 In the PCT-RO-101 Annotate section, double click Validation log to 
see the entire list. 

 

Figure 346: Opening validation log 

 

The validation log opens. 
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3 Scroll through the list to see all the messages. 

 

Figure 347: PCT-RO-101 Validation log, sample data 

 

Note In addition to checking individual sections, the system also carries 
out global validation, that is, it cross-checks the overall correctness of 
the patent application. For example, if in the Biology section you select 
the option to include a sequence listing, in the Contents section the 
traffic light remains red until you attach the mandatory document.  
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49.2 PCT-RO-101 Designating inventor for 
certain states only 

1 In the PCT-RO-101 Annotate section, select the option inventor(s) 
for certain designated States only, and then click Add. 

 

Figure 348: Annotate, inventor for certain states only 

 

The Annotate edit dialog window opens. 

2 Double-click the appropriate inventor name. 

Names are taken from the Names section of the current application. 

 

Figure 349: PCT-RO-101 Annotate, selecting inventor 
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The View/Change Omissions window opens. 

3 Select the states for which this person is the inventor. 

 

Figure 350: PCT-RO-101 Annotate, View/Change Omissions 
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50 Checking forms 

The system checks that the mandatory information is included in the form 
and that the mandatory documents have been attached.  

 
 

50.1 Traffic lights 

A red light signals that mandatory information is missing, for example the 
description of the invention or the claims. You must supply this before 
submitting the form. An amber light indicates that information is useful, 
but not mandatory at this stage, for example the abstract. A green light 
means that the information in this section is acceptable.  

 

 
Red light 

 
Amber light 

 
Green light 

 
 

50.2 Validation messages 

The system checks individual sections and displays validation 
messages. You can access the individual messages from the menu for 
each section. The Annotate section contains the Validation log of all the 
validation messages for the application. 

1 To display individual validation messages related to completing the 
form correctly, click the Validation button in the sections. 

 

Figure 351: Validation button 
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Validation messages are displayed for the current section. 

 

Figure 352: Sample validation messages for EP(1001E), Contents 

 
 

50.3 Previewing documents 

You can preview PDF documents from the form or from File Manager. 

50.3.1 Previewing documents from the form 
1 In the form Contents section, click Open. 

 
 

The Documents window opens. 
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2 Click an item in the list of documents on the left. 

3 Click the Preview button to display the documents in PDF format. 

 

Figure 353: Previewing documents 

 

50.3.1 Previewing documents from File Manager 
1 In File Manager, select the View option By Document. 

2 Click the Reference button to display the list of documents. 

 

Figure 354: View By Document, Opening list of documents 
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3 Double click a document to display it in the PDF Viewer. 

 

Figure 355: Opening PDF Viewer, sample data 

 
 

50.4 Previewing the form 

1 In the form toolbar, click the Preview button to see the form page. 

 

Figure 356: Previewing page 
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The form displays in PDF format, with the information completed so far. 
The example below is taken from EP(1001E). 

 

Figure 357: Form page in PDF Viewer, sample data 
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51 Saving forms 

There are several options for saving your work, available from the File 
menu of the current form. 

 

Option Result 

Save as Ready to be signed Saved in File Manager Ready to Sign 
folder 

Save as Draft Saved in File Manager Drafts folder 

Save as Template Saved in File Manager Templates 
folder 

Export unpacked WAD to... Saved outside Online Filing as XML 
file 

Export WAD to... Saved outside Online Filing as ZIP file 

 
 

51.1 Exporting unpacked WAD 

WAD stands for Wrapped Application Document. This option saves the 
form: all data is saved in XML files and stored, together with all attached 
document files, in a selected directory outside Online Filing as a file in 
XML format. Exported forms can be imported in File Manager. 

 

1 In the form, select Export unpacked WAD to… from the File menu. 

 

Figure 358: Exporting unpacked WAD 

 

The Windows Browse for Folder window opens. 
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2 Navigate to the folder you require and click OK. 

The file is saved in XML format. 

 

Figure 359: Saving as XML, sample data 

 

 

 
 

51.2 Exporting WAD 

WAD stands for Wrapped Application Document. This option saves the 
application outside Online Filing as a compressed file in ZIP format. 
Exported forms can be used as the basis for new forms.  Exported files 
can then be imported in File Manager. 

 

1 In the form, select Export WAD to… from the File menu. 

 

Figure 360: Exporting WAD 

 

The Windows Save as ZIP window opens. 
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2 Navigate to the folder you require and save the file. 

The file is saved in ZIP format. 

 

Figure 361: Saving as ZIP, sample data 
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52 Signing forms 

At least one signature is required on the form. You can add signatures 
from the form itself or from File Manager. For more information see 
Ready to Sign folder (p 32). 

1 In the completed form, click the Sign button.  

 
 

The Submission Preparation Progress window opens.  

2 Click Continue. 

 

Figure 362: Submission Preparation Progress, Continue, sample data 

 

The Submission Preparation Progress window expands as Online 
Filing checks that all the required information is included. When Online 
Filing finishes its checks, the Close button appears. 
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3 Click Close. 
  

 

Figure 363: Submission Preparation Progress, Continue, sample data 
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Online Filing prepares the list of PDF documents for you to check. This 
may take a few moments. The documents may vary depending on the 
type of form. 

When this list is ready the PDF Viewer window opens. Click the 
documents on the left to see them if you wish.   

1 Once you are satisfied that the correct documents are attached, click 
Sign Now. 

 

Figure 364: PDF Viewer, Sign Now, EP(1001E) sample data 

 

Note If you decide that the form is not ready to sign, click Cancel in the 
PDF Viewer window. Back in the Ready to Sign folder right-click the 
form and select the Return to Drafts option from the shortcut menu. 

 

The List of Signatories window opens. For EP(1001E) the choice of 
signatories includes: 
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§ Any applicants or representatives from the Names section. 
§ Signatories from the Address Book. 
§ Names you type in at this point. Use the blank white space to the left 

of the Add Signatory button. 

1 Select or enter the signatory name and click Add Signatory. 

 

Figure 365: EP(1001E) Add Signatory, sample data 
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Note The List of Signatories window for Euro-PCT(1200E) and 
EP(1038E) reflects the options appropriate to those forms. 

 

Figure 366: Euro-PCT(1200E) List of Signatories 

 

The Signature window opens. Note that there are three legal signatures:  
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§ Alphabetical 
§ Facsimile 
§ Digital 

For more information see Types of signature (p 249). 

1 Select the type of signature you wish to add. 

2 Click Apply Signature. 

 

Figure 367: Signature, Advanced digital 

You will see a message that signing is in progress. Once Online Filing 
has finished this process, File Manager opens. 

Note If alphabetical or facsimile signatures are applied, the form remains 
in the Ready to Sign folder. You can add more signatures and move the 
form to the Ready to Send folder when you are ready. If a digital 
signature is applied, the form is moved automatically to the Ready to 
Send folder. For more information see Types of signature (p 249). 
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52.1 Types of signature 

There are three legally recognised types of signature: 

1 Alphabetical 
An alphabetical signature is typed in. 

2 Facsimile 
A facsimile signature is an electronic file containing a scanned image 
of a handwritten signature. 

3 Digital 
A digital signature makes use of a smart card with a PIN. 

Note If you use the digital signature option, only one signatory is allowed 
as the digital signature is also used to encrypt the package of all data 
files of the application or request. Once signed, the form then moves 
automatically to the Ready to Send folder. You may add more than one 
signature using the alphabetical or facsimile options. In this case, the 
form remains in the Ready to Sign folder. When the signatures are 
complete, right-click the form in File Manager and select Move to Ready 
to Send from the shortcut menu. If you make any changes to the 
information after signing, the signature is removed and the form is 
returned to the Ready to Sign folder.  

 

Figure 368: Ready to Sign, Move to Ready to Send 
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52.2 Adding alphabetical signatures 

1 In the List of Signatories window select a Capacity. 

2 Select a signatory from the list or enter a name. 

3 Click Add Signatory. 

 

Figure 369: EP(1001E) Add Signatory, sample data 

 

The Signature window opens. 

4 Select the Alphabetical option. 

5 Type in a forward slash /, then the signature, then type in another 
forward slash / to finish, for example /Firstname Surname/. 

Note If the slashes are not typed, a warning message appears and they 
are added automatically by the system. 
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6 Click Apply Signature. 

 

Figure 370: Signature, Alphabetical, Apply Signature 

 
 

52.3 Adding facsimile signatures 

1 Prepare the signature as an image file.  

This may be in either TIFF (*.TIF) or JPEG (*.JPG) format, and the file 
name must not contain any spaces. 

The default is TIFF. 
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2 In the List of Signatories window select a Capacity. 

3 Select a signatory from the list or enter a name. 

4 Click Add Signatory.  

 

Figure 371: EP(1001E) Add Signatory, sample data 

 

The Signature window opens. 
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5 Select the Facsimile option. 

6 Click the Browse button and navigate to the image file location. 

 

Figure 372: Facsimile signature, Browse to file location 

 

7 Select file format and the image. 

 

Figure 373: Selecting facsimile signature 
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8 Back in the Signature window click Apply Signature. 

 

Figure 374: Applying facsimile signature 
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52.4 Adding digital signatures 

1 In the List of Signatories window select a Capacity. 

2 Select a signatory from the list or enter a name. 

3 Click Add Signatory. 

 

Figure 375: EP(1001E) Add Signatory, sample data 
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52.4.1 Smart cards 
The European Patent Organisation provides authorised users with smart 
cards for use with digital signatures.  

The smart card is a high security device that encrypts the signature. To 
add a digital signature, insert your smart card into a reader and type your 
PIN when prompted. The smart card software needs to be installed 
beforehand.  

The smart card is created by a certification agency. It contains: 

§ The private key of the user. 
§ The public key of the user. 
§ A certificate testifying that this particular public key has been 

allocated to this particular user. 

Each user must have his or her own smart card. If there are several 
people within a company with the right to sign and/or submit applications, 
they must each have their own smart card. 

 

Figure 376: Inserting smart card 

1 Make sure that the smart card reader is switched on and working 
properly.  
The light on the side of the reader should be shining continuously, 
rather than blinking.  

Note The light will only shine continuously once the smart card has been 
inserted. Otherwise it will blink.  

When an attorney leaves a company, the company should inform EPO 
Customer Services and have the card revoked. The company should give 
the EPO the identity of the attorney taking over the files. The files are 
then detached from the previous FREP and attached to the new one. 
After this has been done the previous attorney will no long be able to see 
the files as 'his assets' . 
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Smart cards may never be shared; each and every person in a company 
who has the right to access epoline® Online Filing should apply for a 
personal smart card. These should not be given to any other employee. 
The personal smart card enables the bearer to carry out any function for 
which he has been granted authority. 
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53 Sending forms 

The sending process is initiated from File Manager.  

§ The system checks that all the mandatory information is present.  
§ You enter a PIN, using a smart card. 
§ The form is transmitted over a secure Internet link. 
§ The system issues a receipt confirming date and time of 

transmission and, in the case of EP filings, the application number 
as well. 

 
 

53.1 Deciding not to send 

You can decide that the form is not ready to send and move it out of the 
Ready to Send folder.  

1 In the File Manager Ready to Send folder, right-click the form and 
select Return to Drafts from the shortcut menu. 

Or 

Select Return to Ready to Sign. 

 

Figure 377: Ready to Send, Return to Drafts 
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53.2 Pre-transmission checks 

Sending a form requires a smart card and a PIN. The system checks 
that all the mandatory information is present before it transmits the form. 
For additional options see Ready to Send folder (p 33). 

1 In the File Manager Ready to Send folder right-click the form and 
select Send from the shortcut menu.  

You can also double-click the form. 

 

Figure 378: Sending a form 

 

2 When prompted click Continue Sending. 

Or  

If you decide not to proceed, click Stop Sending. The form remains in 
the Ready to Send folder. 
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 If you are submitting a real filing, make sure that you are sending the 
form to the production server and not the demo server. 

 

Figure 379: Pre-transmission checks, Continue Sending 

The system checks that the mandatory information is present. 

 
 

53.3 Entering a PIN 

Once the pre-transmission checks are complete, the Please enter PIN 
window opens. 

 

Figure 380: Please enter PIN 
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1 Enter your PIN. 

2 Follow the prompts to complete the submission. 

During the submission process a progress indicator displays the 
percentage of data sent. You can click the Cancel button to stop the 
submission. 

 

Figure 381: Progress indicator, Sending Data 

 
 

53.4 Viewing receipt and reference number 

As soon as your submission has been successfully completed, the 
system issues a receipt.  

1 To view the receipt, click Yes when prompted. 

 

Figure 382: Prompt to view receipt 
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2 When the PDF Viewer opens, view the receipt and then click Cancel. 

 

Figure 383: Receipt information, sample data from demo submission 

 

Note To view a receipt again in future, double-click it in the Sent folder, 
with the View By Document selected. 
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Figure 384: Opening receipt from Sent folder 

 

You can also print the receipt from the PDF Viewer toolbar. 
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Figure 385: Receipt in PDF Viewer, Print option 
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53.5 Loading a form onto a CD 

You may set the default option in File Manager, Tools, Settings. For 
more information see CD-R submission (p 6). Or you may select CD-R 
as the method of submission for an individual form. 

1 In File Manager right-click a form in the Ready To Send folder. 

2 In the shortcut menu click Send. 

3 When prompted enter your PIN. 

4 When prompted, save the file to a directory of your choice. 
The name is taken from the user reference ID and given the file 
extension SGN. 

5 Write the saved file to a recordable CD and send it to EPO Customer 
Services by post for uploading to the server. For the address see 
EPO Customer Services. 
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54 Appendix 

54.1 Online Filing keyboard shortcuts 

Shortcut Description 

Ctrl+B Opens the Address Book. 

Ctrl+C Copies selection. 

Ctrl+D Deletes selection. 

Ctrl+Q Exits File Manager. 

Ctrl+V Pastes selection. 

Ctrl+X Cuts selection. 

Ctrl+Z Undoes the last action. 

F5 Refreshes the view. 

 
 

54.2 Export and Import summary 

The following table summarises the options for saving files to external 
storage areas, and retrieving them. More detailed information is provided 
in the documentation for File Manager and the forms. The terms used are 
defined in the Glossary of terms in the Appendix. 

 

Menu command Location Result 

Address Book   

File, Export, 
Address Book 

File 
Manager 

Saves Address Book as an 
external file in CSV format. 

See Exporting Address Book 
names (p 42). 

File, Import, 
Address Book 

File 
Manager 

Retrieves external Address Book 
information saved in CSV format. 

See Importing Address Book 
names (p 43). 

Forms   
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Menu command Location Result 

File, Export, 
Forms 

File 
Manager 

Backs up folders and their 
associated forms to an external 
storage area. 

See Exporting folders (p 15). 

File, Export, 
Forms,  
Delete items 
option selected 

File 
Manager 

Archives folders and their 
associated forms to an external 
storage area and also removes 
them from Online Filing central 
directory.  

See Exporting folders (p 15). 

File, Import, 
Forms 

File 
Manager 

Retrieves archived folders. 

See Importing folders (p 18). 

File, Export WAD 
to... 

Online 
Filing 
procedures 

Saves forms as XML file in 
compressed ZIP format. 

See Exporting WAD (p 241). 

File, Import, XML 
from file 

File 
Manager 

Retrieves forms saved as XML 
file in compressed ZIP format. 

See Importing XML from file 
(ZIP files) (See "Importing XML 
from file (ZIP format)" p 21). 

File, Export 
unpacked WAD 
to... 

Online 
Filing 
procedures 

Saves forms as XML format. 

See Exporting unpacked WAD 
(p 240). 

File, Import, XML 
from folder 

File 
Manager 

Retrieves forms saved as XML 
format. 

See Importing XML from folder 
(p 22). 
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54.3 Sample EP(1001E) filing 

The following example follows an EP(1001E) filing through the various 
stages of submission. Four sample documents were attached in the 
EP(1001E) Contents section: Description, Claims, Drawings and 
Abstract. The documents are displayed using the View By Document 
option in File Manager.  

Drafts folder 

All attached documents are viewable, as well as the system-generated 
files necessary to provide consistency and integrity during transmission: 
application-body.xml, ep-request.xml, package-data.xml and 
pkgheader.xml. 

 

File Comment 

pkgheader.xml Identifies the sender. Contains a digest of the 
submission to ensure that what is expected to arrive 
is identical to what actually arrives.  

package-data.xml References all the files as a checklist of what is 
transmitted. 

application-body.xml References all the technical PDFs. 

ep-request.xml Contains all the information entered on the form. 

 

 

Figure 386: Sample EP(1001E) documents in Drafts folder 

 

Ready to Sign folder 
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For this list, another document appears. An image file in JPG format has 
been added as a facsimile signature, signature.jpg. An application 
signed with an alphabetical or facsimile signature remains in the Ready 
to Sign folder until moved manually. 

Another document appears, EPF1001.PDF. This is the application form 
itself as it appears with the signature added. 

 

Figure 387: Sample EP(1001E) documents in Ready to Sign folder 

 

Double-click any document you wish to view.  

 

Figure 388: Viewing sample EPF1001 form 

 

The document opens. You can use the PDF Viewer toolbar, for example 
to save the document as a PDF document in your own filing system, or to 
print it. Move your pointer over an icon to see a tooltip. Use the 
navigation buttons in the lower part to move through the pages. Scroll 
through the pages, and then click Cancel. 
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Figure 389: EPF1001 Request in PDF Viewer, Save option 

 

Ready to Send folder 

The sample file has been moved manually from the Ready to Sign 
folder. The list of documents is unchanged. You can open the file in 
View/Edit mode at this stage. However, if you make any changes, the 
signature is removed and the document is returned to the Ready to Sign 
folder. 
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Figure 390: Sample EPF1001 documents in Ready to Send folder 

 

Sent folder 

The submission has been completed successfully. The Receipt of 
Electronic Submission is added to the list. The receipt is provided in 
two different formats, XML and PDF. 

 

Figure 391: Sample EP(1001E) documents in Sent folder 

 

To view a receipt at any time double-click it in the Sent folder. You can 
also save or print the receipt from the PDF Viewer toolbar. 
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Figure 392: Receipt in PDF Viewer, Print option 

 

Error receipts 

After the data has been received by EPO, you may receive a receipt 
indicating that an error occurred during validation. If this happens, please 
contact EPO Customer Services (p vi). 
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Figure 393: Sample error receipt 
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55 Portable Document Format hints and tips 

The following hints and tips are provided to assist you in preparing 
documents in Adobe® Portable Document Format (PDF), which is an 
open standard for electronic document distribution. Adobe® PDF 
preserves all the fonts, formatting, graphics, and colour of any source 
document, regardless of the application and platform used to create it. 

The European Patent Office can only accept documents prepared in PDF 
with the correct settings. The key points to remember are: 

§ For any document that includes characters such as mathematical 
formulae and Greek characters, ensure that the font set you use 
includes these characters. 

§ Paper size must be A4. 
§ Page orientation must be Portrait. 

PDF documents can be created with a number of tools, one of which, 
Amyuni® PDF Writer, is delivered with the Online Filing software. This 
software package is less feature-rich than Adobe® Acrobat, but it is 
reliable and easy to use. There are many other products on the market 
that generate PDF documents. You many select any tool which produces 
PDF documents in PDF 1.2 format. 

55.1 Fonts in PDF documents 

A PDF document is the electronic equivalent of a paper printout. It should 
be checked carefully. There are a few areas where problems might occur, 
especially in the field of font embedding.  

There are two ways of using fonts in a document, linking and 
embedding.  
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55.2 Embedding fonts 

Embedding means that the font is included with the document, so the 
entire package is self-contained. This is the appropriate option when 
sending it outside your own system.  

We strongly recommend that you use standard fonts only, that is, fonts 
which are included in the set which come with the Adobe® PDF Reader. 
But if you have to use a non-standard font, for example to use symbols 
not available otherwise, you must ensure that this font is embedded. 

If you are using special copyright-protected fonts, you must also ensure 
that you have sufficient rights to embed the font with your document. You 
should note the following from the Adobe® Acrobat guide: 

“A TrueType font can contain a setting added by the font’s designer that 
prevents the font from being embedded in PDF files. Even though you 
can move such a font to an embed list, Distiller does not embed it in the 
PDF file, but displays an error message and lists the font in the log file. 
You can check whether the font was embedded by opening the resulting 
PDF file and viewing the Font Info dialog box.”  

As a general rule programs used for PDF provide an option to embed all 
fonts. The suggestions below describe the options for two in particular, 
Adobe® Acrobat  and Amyuni®. For other software products, please consult 
the manufacturer. 
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55.2.1 Font embedding with Adobe® Acrobat 
Adobe® Acrobat provides two ways of producing PDF documents, PDF 
Writer and Distiller. As a general rule of thumb, use Distiller for more 
complex documents, for example those that include graphics and 
specialised fonts. 

Embedding all fonts in Distiller is done in a configuration file called 
epoline.joboptions. This file has to be copied into the Distiller settings 
directory, usually: 

C:\Program Files\Adobe\Acrobat 4.0\Distillr\Settings 

Adobe® automatically installs files for press, print and screen optimised 
PDF output in this directory, with default setting as shown below. The 
Embed All Fonts option is selected automatically. It might be a good 
idea to make the file epoline.joboptions read-only. 

 

Figure 394: Acrobat Distiller settings 
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Figure 395: epoline Job Options 

 

55.2.1 Adobe® Acrobat upgrades 
Up to and including version 1.01e of the Online Filing software, only 
Adobe® Acrobat 4.0x as conversion tool is supported. The system must 
not be upgraded to Acrobat 5 or later. 

 

55.2.1 PostScript printer 
Installation of a PostScript (PS) printer driver is mandatory when using 
Adobe® Acrobat Distiller, even if there is no physical printer attached to 
the computer system. Version 4.0 of Adobe® Acrobat which was delivered 
with the first Online Filing software packages did not force the applicant 
to install a PS printer driver, whereas Version 4.05 (a maintenance 
release from Adobe® Acrobat) did. 
 



 

 Portable Document Format hints and tips 279 
 
 

55.2.2 Font embedding with Amyuni® 
For the Amyuni® PDF Converter, font embedding is done after Amyuni® 
PDF Converter has been selected as printer.  

Font embedding in PDFs is important because the generated PDF files 
are relocated from the applicant's PC to an EPO server. In order to 
prevent any missing characters, Amyuni® is configured in such a way that 
the on-screen options shown here cannot be changed. 

To view the settings: 

1 Select File, Print from the document menu. 

2 Select Amyuni® PDF Converter as the printer. 

3 In the Print dialogue window select Properties.  

The Amyuni® PDF Converter Properties window opens. 

 

Figure 396: Amyuni PDF Converter options 
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55.2.3 Identification of possible problem areas 
It might be useful to identify and test possible problem areas in advance. 
There are multiple computer platforms, and virtually hundreds of 
applications that can generate Portable Document Format. It is next to 
impossible to test all of these application/platform combinations and 
evaluate how they might handle certain complex document conversions. 
We recommend that you restrict yourself to the platform/application 
combination that you plan to use for PDF conversion, then identify any 
complex elements that future application documents might include. A few 
examples of complex elements are: 

§ Uncommon fonts. 
§ Non-Latin characters, for example the euro symbol €. 
§ Any Greek, Russian, Hebrew, Arabic or other characters. 
§ Embedded mathematical formulas or other embedded objects. 
§ Superscripts and subscripts. 

 

Once those complex elements common to the application documents 
have been identified: 

1 Create a test document with the authoring tool you intend to use, for 
example Microsoft® Word for Windows.  

2 Try converting it to PDF on the relevant computer platform. 

 

When you achieve a PDF that looks exactly like the original word-
processed document, use the same settings for real online patent 
applications.  

The figures below illustrate an example with special characters, prepared 
in Microsoft™ Word for Windows and viewed in PDF format with Adobe® 
Acrobat Reader. 

 

Figure 397: Font embedding, test Word document 
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Figure 398: Font embedding, test Adobe Acrobat document 

 

55.2.1 Which tool is the best? 
No statement can be made as to which of the tools might be the best. 
Although Adobe® PDF Distiller is generally considered as the reference, it 
should be pointed out that the test approach described above is 
recommended as a way of finding out what suits your requirements the 
best. In some cases, Adobe® Acrobat PDF Writer with font embedding 
selected, or any other PDF generating tool, can do the job as well as the 
tools in the Online Filing package. 

 

55.2.1 How to check that a PDF file is self-contained 
If a non-standard font has been used in the creation of a technical 
document, then it is important to preview the file on a PC where this font 
is not installed in order to check whether the characters are indeed 
embedded. Therefore we advise using different PCs for the creation of 
the technical documents and for the electronic filing, at least once, to 
ensure that the selected PDF generating method is working properly. 
Make sure that the non-standard fonts are not installed on the PC used 
for electronic filing (and re-viewing of the PDF files). Using a PDF viewer 
other than Adobe® Acrobat could be an option as well. For more 
information see Ghostscript and Ghostview (p 284). 
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55.2.2 Paper size 
Rule 35(4) EPC stipulates that “The documents making up the 
European patent application shall be on A4 paper ...”.  For the full text 
see our website: 

EPO legal provisions website, Rule 35 (http://www.european-patent-
office.org/legal/epc/e/r35.html) 

This rule should also be followed for electronic filings, even though 
electronic rather than physical paper is being used. Any PDF generation 
software should be set to A4 paper size, that is:  

§ 29.7 cm x 21.0 cm (or 8.267" x 11.693") 
§ portrait orientation (landscape should be avoided).  

 

Set the page size to A4 in both your word processor and the PDF 
generator.  

To set Distiller to A4: 

1 Select Printer Properties. 

2 Select the Advanced option 

3 Select Portrait mode. 

 

Figure 399: AdobePS Acrobat Distiller, Advanced Options 
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To set Amyuni® to A4: 

1 Select the A4 option directly under Printer Properties. 

This seems to be especially important when drawings are not generated 
by graphic programs but are scanned and converted to PDF files. For any 
PDF filings that do not follow this rule, the EPO internal image database 
might then contain pages with black areas filling the remaining area 
between the unintentionally chosen format and A4 format. 

 

Figure 400: Amyuni PDF Converter paper size 

 

 
 



 

284 epoline® Online Filing User guide 
 

55.2.3 Ghostscript and Ghostview 
When checking that a PDF file is self-contained, you may wish to try a 
PDF viewer other than Adobe® Acrobat, such as Ghostview®. First, 
install the latest supported version of Ghostscript® and then Ghostview®.  

For more information on Ghostscript® and Ghostview® see the GNU 
website. 

Both of these products are under GNU public licence and give Windows 
users the ability to preview how the PDF file will be converted at the 
European Patent Office. Ghostview® is an alternative viewer which can 
also display PDF files. The EPO uses a Ghostscript®-based program to 
feed incoming PDF documents into its internal image database, so 
previewing PDF files with Ghostview® is another way to check that PDF 
files will be converted correctly at the EPO.  

The figure below shows the test example prepared in Microsoft™ Word 
for Windows as it is displayed with Ghostview®. 

 

Figure 401: Font embedding test Ghostview 

 
 

55.2.4 Generating PDF documents using a scanner 
A scanner is very useful for drawings and all sorts of technical 
documents. However you should not use any default settings of the 
scanning/capturing software that might influence the virtual paper size of 
the PDF documents. Before starting the scan process, the scan area has 
to be set to DIN A4, Portrait. For more information see Paper size (p 
282). 
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55.3 Linking fonts 

Linking is a way to reference the font where it is stored on your own 
computer system. The advantage of this is that the document file size can 
be smaller. The disadvantage is that if you send the document to another 
system, as is the case with Online Filing, the linked information cannot be 
referenced. Specialised fonts, for example ones that use mathematical 
symbols, Greek characters or other non-Latin alphabets, may not be 
interpreted correctly.  
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56 Glossary of terms 

A 
Administrator 
Within the context of user management, a 
person who can create accounts and assign 
passwords for other roles. Cannot carry out the 
functions related to preparing, signing or 
sending patent applications. 

 
 

ASCII file 
American Standard Code for Information 
Interchange. May contain letters, numbers, 
spaces and punctuation, but no formatting. 
Also called a text file. 

 
 

Assistant 
Within the context of user management, a 
person who can prepare patent applications. 
Cannot sign or send applications. 

 
 

B 
Binary file 
A file consisting of a sequence of 8-bit 
computer code, as distinguished from files 
consisting of human-readable text. Readable 
only by computer programs. 

 
 

Browser 
Internet software that lets a user view HTML 
documents and access files and software 
related to those documents. 

 
 

C 
CD-R 
Compact Disk - Recordable disk. Another 
method of submission for online filing. 

 
 

Check box 
A small square box that is selected or cleared 
to turn an option on or off. When an option is 
selected, an x or a check mark appears in the 
box. Where there are several check boxes in a 
set, more than one can be selected. 

 

 
 

Click 
To press the primary mouse button once 
without moving the mouse. The primary mouse 
button is the more frequently used button. This 
is generally the one on the left. Clicking selects 
or deselects an item. 

 
 

Client 
As applied to computers, a process, such as a 
program or task, that requests a service 
provided by another program. 

 
 

Clipboard 
A temporary storage area in Windows®. 

 
 

Close button 
The small X in the top right corner of the 
screen that shuts the active window. 

 

 
 

CSV 
Comma Separated Values. A format typically 
used for saving files where the data is 
arranged in columns and rows. The 
information can be imported or exported, the 
commas marking where the next item of 
information starts. 
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D 
Default 
An automatic selection made by the system 
when the user does not specify an alternative. 

 
 

Double-click 
To press and release the mouse button twice 
without moving the mouse. The first click 
selects and the second activates a program or 
program feature. 

 
 

Drag 
To move an item from one place to another on 
the computer screen. The mouse pointer is 
positioned over the object, and the mouse 
button is pressed and held while the mouse is 
moved to the new location. 

 
 

Drop-down 
A set of options that appears when you click 
the drop-down arrow.  

 

The menu remains open without further action 
until you close it or choose a menu item. 

 
 

DTD 
Document Type Definition is a file containing 
specific set of rules for how an XML document 
should look and how the elements of the 
document relate to each other.  

 

 
 

E 
Embed 
A way to insert information, for example 
images or fonts, into the current document, so 
that it becomes part of the document. This is 
the appropriate option when sending a 
document outside your own system.  

 
 

Extension 
A set of characters added to a file Identifies 
what kind of computer application was used to 
produce the file. Typically three characters, 
separated from the file name by a full stop, for 
example, sample.doc would identify the 
document as produced in Microsoft® Word for 
Windows. 

 
 

F 
Firewall 
A security system intended to protect an 
organisation's network against external threats. 
Usually a combination of hardware and 
software that prevents computers in the 
organisation's network from communicating 
directly with computers externally to the 
network. Instead, all communications are 
routed through a proxy server outside of the 
organisation's network, and the proxy server 
decides whether it is safe to let a particular 
message or file pass through to the 
organisation's network. 

 
 

G 
Grey-scale 
A sequence of shades ranging from black to 
white, used in computer graphics to add detail 
to images. 
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H 
HTML 
Hypertext Markup Language. The markup 
language used to format documents so that 
they can be interpreted and rendered by an 
Internet browser. 

 
 

I 
IP address 
Internet Protocol address. A number that 
uniquely identifies a host computer connected 
to the Internet, for the purpose of 
communication. 

 
 

J 
JPG 
Joint Photographic Engineering Group. A 
standard for storing images in compressed 
form. JPG files may be used for scanned 
signatures. 

 
 

L 
Legal person 
A corporate entity and cannot sign patent 
applications. 

 
 

Legal Representative 
Within the context of user management, a 
person who cannot create or manage 
accounts. Can carry out all functions related to 
patent applications, that is, prepare, sign and 
send them. 

 
 

Link 
A way to reference data, for example images 
or fonts, stored outside of the current 
document. The advantage of this is that the 
document file size can be smaller. The 
disadvantage is that if you send the document 
to another computer system, the linked 
information cannot be referenced.  

 
 

M 
Markup 
Information added to a document that 
enhances its meaning in certain ways, in that it 
identifies the parts and how they relate to each 
other. A markup language is a set of symbols 
placed in a document to demarcate and label 
that document. Important to electronic 
documents because they are processed by 
computer programs. Allows the computer to 
distinguish one piece of text from another and 
treat it appropriately. 

 
 

N 
Natural person 
An individual who can be an applicant and/or 
an inventor. 

 
 

Note (for EPO) 
A comment intended for those receiving the 
application, as part of the data submitted. 

 
 

Note (internal) 
A note for internal use only, not transmitted to 
the EPO. 
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O 
Option button 
Appears as a small circle. Used to select one 
of a group of options. When an option is 
selected it has a smaller, filled circle inside it. 
In a set of options, only one can be selected at 
a time. 

 

 
 

P 
PDF 
Portable Document Format. A file format used 
in saving documents. 

 
 

PIN 
Personal Identification Number used for 
transmitting information electronically over a 
secure Internet link. 

 
 

Port 
A device for directing communication or 
channelling data between one computer and 
another. 

 
 

Proxy server 
A firewall component that manages Internet 
traffic to and from a network. 

 
 

R 
Right-click 
To press and release the secondary mouse 
button. Typically displays a shortcut menu of 
options. 

 
 

S 
Secretary 
Within the context of user management, a 
person who cannot prepare or sign patent 
applications. Sole function is to send 
applications. 

 
 

Server 
A computer running software that controls 
access to a network and its resources. 

 
 

SSL 
Secure Socket Layer. A protocol developed by 
Netscape Communications Corporation for 
ensuring security and privacy in Internet 
communications. Supports authentication of 
client, server, or both, as well as encryption 
during a communication session. 

 
 

T 
TIFF 
Tagged Image File Format. A standard file 
format commonly used for scanning and 
storing grey-scale images. TIF files may be 
used for scanned signatures. 

 
 

TXT 
Text. A file format used in saving documents in 
machine-readable form. 

 
 

U 
URL 
Uniform Resource Locator. An address for a 
resource on the Internet. Used by Web 
browsers to locate Internet resources. 
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V 
VPN 
Virtual Private Network. Provides a secure 
means of electronic transmission. 

 
 

W 
WAD 
Wrapped Application Document. This option 
saves the form as XML files and all its 
attachments in one compressed file. 

 
 

X 
XML 
The eXtensible Markup Language is a 
document processing standard officially 
recommended by the World Wide Web 
Consortium and widely accepted throughout 
the Internet community. Provides a way to 
define and manage information. It can be used 
to check the accuracy and quality of 
documents.  

 

 
 

Z 
ZIP 
A format using for saving documents. Zipped 
files are compressed so that they take up less 
space and take less time to transmit 
electronically than equivalent unzipped files. 
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